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PART 1 GENERAL

INFORMATION
1.1 INTRODUCTION

The DynaMax boiler is a fan assisted boiler based on a
push through design which offers several venting options.
Heat output is controlled by a one to one air/gas ratio
control gas valve which provides seamless modulation. The
boiler provides central heating, domestic hot water or
combination heating with DHW priority at working pressure
up to 160 PSI. It is designed for use with a fully pumped
and pressurized water system. The boiler/water heater will
automatically modulate to provide heat outputs from 100%
down to approximately 20% of rated input.

The DynaMax utilizes a negative pressure gas valve. The
operation of the fan will generate a negative pressure in the
venturi, which draws in a matching amount of gas through
the valve.

During operation the DynaMax maintains a steady state
efficiency across the entire range of modulation. Air and
gas are metered in precise proportion (1:1 Ratio) allowing
combustion characteristics which determine efficiency to
remain the same over the entire operating range.

The DynaMax is designed so that all of the sensible heating
value and most of the latent heat is being transferred to the
water.

1.2 SPECIAL INSTRUCTIONS TO OWNER

This manual supplies information for the installation,
operation and servicing of the appliance. It is strongly
recommended that this manual be reviewed completely
before proceeding with an installation

CAUTION
It is important that all gas appliances are installed by a
qualified installer/technician that is trained by Camus
Hydronics. It is in your own interest and that of safety to
ensure that all local codes, and all the following “NOTES”
and “WARNINGS” are complied with.
Installing, servicing or adjusting this appliance should be
performed only by a qualified installer/technician that is
trained by Camus Hydronics. The serviceman must utilize a
combustion analyzer with CO,, CO, and draft gauge, to set
the appliance according to Camus Hydronics’
recommendations, prior to commissioning.

NOTE

RETAIN THIS MANUAL FOR FUTURE REFERENCE

1.3 CHECKING EQUIPMENT

Check for signs of shipping damage upon receiving
equipment. Pay particular attention to parts accompanying
the boiler, which may show signs of being hit or otherwise
being mishandled. Verify total number of pieces shown on
packing slip with those actually received. In case there is
damage or a shortage, immediately notify carrier.

1.4 DISPLAY UNIT

The display unit will indicate status and will display selected
temperature. Refer to Part 9 DynaMax Control Panel, which
provides details to modes and error codes displayed on the
appliance.
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SEQUENCE OF OPERATION

The power switch is placed in the “ON” position.
Minimum 120 VAC 60Hz single phase (15A circuit) is
supplied to the DynaMax Field Connection Board.

120 VAC power is supplied to the DynaMax Controller
which provides all setup and ignition control functions.
Access to settings is through the use of a LPT1/ USB
cable using a laptop computer through the LPT1 port
on the DynaMax Control Panel.

After the appliance water pump starts, flow is proven
by the flow proving device. The normally open dry
contacts in the low water cutoff (LWCO), if supplied, is
to be wired in series with the normally open contacts of
the flow proving device. (Refer to Figure 18, page 18 of
this Manual)

Locate the probe type LWCO in the piping at least 3
feet above the boiler inlet/outlet connection. In all
cases check with local codes.

Depending on the selected mode, the appliance
operates as a master or slave configuration.

The DynaMax Controller initiates a start-up sequence
once it receives a heat demand.

The DynaMax Controller energizes the on-board pump
and starts to ramp up the voltage to the electrically
commutated DC motor of the combustion fan.

The fan will run at Pre-Purge speed until the Pre-Purge
timer is satisfied. Once this is complete the DynaMax
Controller provides a signal to modulate down to
ignition fan speed.

The DynaMax controller goes through internal safety
checks and if this is satisfied the ignition sequence
begins.

The DynaMax Controller supplies voltage to the air/gas
ratio control valve. The air/gas ratio control valve
senses the pressure across the venturi and supplies
gas to pre-mix with air.

The igniter will continue to spark for 6 seconds, with
the gas valve opened, and the fan running at ignition
speed.

Spark Igniter lights the air/gas mixture. The DynaMax
Controller looks for a minimum flame rectification
signal of 1.25 pA DC from the flame sensor. If the
signal is present the DynaMax Controller will allow the
gas valve to remain open. The burner is now firing at
starting input rate.

The boiler will modulate to the correct fan speed to
meet the heat demand. The modulation rate is
controlled via Pulse Width Modulation (PWM) signals
provided by the DynaMax Controller.

The fan speed will slowly decrease as the heat request
nears the heat demand. If the heat demand is
sustained for a long duration of time the boiler will get
to a point of steady-state and the fan will rotate at a
constant speed.

When the heat demand is satisfied or is removed the
burner will shut off and the fan speed will ramp up to
the preset Post-Purge speed until the Post-Purge
Timer is satisfied.

The boiler will then go into Standby as it awaits for the
next heat demand.



Table 1: DynaMax Ignition Cycle (in LabVision)

State

Standby [Pre-Purge] Safety On |Safety Offf Ignit_0 Ignit_1 Burn
Ssex afer Limited to 24
Time 0on an spee 2 sec b sec hrs
is within Canti I
300 RPM ontinuously
Demand 0 . X . il . LD . L A =0
influence | influence | influence | influence | influence
Ignition Ignition Ignition Ignition Ignition Requested
Fan [RPM o
. . Speed Speed Speed Speed Speed Power
Gas Valve [ Closed Closed Closed Closed Closed Qpen Open
Spark o off o of on on4 ot
I Flame must| Flame must
lonisation 0 i
. . . g be detecied] be detected
Note:

1. If aflame signal is detected at the end of the pre-purge
period a lockout will occur.

2. If at the end of the safety period (6 sec) no flame is
detected the control will go to post-purge to remove the
unburned gas. After this, a re-ignition attempt is started
following the same cycle. The number of re-ignition
attempts is limited to 2 after which a lockout occurs.

3. The burner can only be on continuously for a period of
24 hours. After this the burner is switched off and a
restart sequence follows.

4. Sparking stops 2 seconds before the end of the ignition
period to allow for ionisation detection.

1.5.2 Heat Transfer Process

1) Burner Input continues to increase until outlet water
temperature reaches the Set Point temperature.

2) Burner Input may stabilize at a fixed rate where
demand equals input.

3) Burner Input will decrease rate when outlet water
temperature approaches temperature Set Point.

153 End of Sequence

1) Set Point temperature is satisfied.

2) Power to the gas valve is turned off.

3) Combustion Air Fan ramps to a stop over the factory
preprogrammed time period.

4) Thermostat is now in standby mode waiting for the next
“Call for Heat".

IMPORTANT

Consult and follow local Building and Fire Regulations and
other Safety Codes that apply to this installation. Contact
the local gas utility company to inspect and authorize all
gas and flue connections.

Installation and service must be performed by a
qualified technician/installer, and trained by Camu s
Hydronics.

WARNING

Should overheating occur or the gas supply fails to shut off,
DO NOT turn off or disconnect the electrical supply to the
pump. Shut off the gas supply at a location external to the
appliance.

WARNING

To minimize the possibility of serious personal injury, fire or
damage to your appliance, never violate the following
safety rules.

DO NOT

Do not use this appliance if any part of it has been under
water. The possible damage to a flooded appliance can be
extensive and present numerous safety hazards. Any
appliance that has been under water must be replaced

WHAT TO DO IF YOU SMELL GAS

Do not try to light any appliance. ¢« Do not touch any electric
switch: do not use any phone in your building. °
Immediately call your gas supplier from a neighbor’s phone.
Follow the gas supplier’s instructions. ¢ If you cannot reach
your gas supplier, call the fire department.

« Boilers and water heaters are heat producing
appliances. To avoid damage or injury, do not store
materials against the appliance or the vent-air inlet
system. Use proper care to avoid unnecessary contact
(especially children) with the appliance and vent-air
inlet components.

« Never cover appliance, lean anything against it, store
trash or debris near it, stand on it or in any way block
the flow of fresh air to appliance.

¢ UNDER NO CIRCUMSTANCES may flammable
materials such as gasoline or paint thinner be used or
stored in the vicinity of this appliance, vent-air inlet
system or any location from which fumes could reach
the appliance or vent-air inlet system.

¢ Agas appliance that draws combustion air from the
equipment room where it is installed must have a
supply of fresh air circulating around it during burner
operation for proper gas combustion and proper
venting.

1.6 INSTALLATION CODES

The equipment shall be installed in accordance with

those installation regulations enforced in the loca | area
where the installation is to be made.  These shall be
carefully followed in all cases. Authorities having jurisdiction
shall be consulted before installations are made. In the
absence of such requirements, the installation shall
conform to the latest edition or current as amended of the
National Fuel Gas Code, ANSI Z223.1 and/or CAN/CGA-
B149 Installation Code. All electrical wiring must be done in
accordance with the requirements of the authority having
jurisdiction or, in the absence of such requirements, with
national electrical code, ANSI/NFPA70 and/or the Canadian
electrical code part 1 CSA C22.1. Where required by the
authority having jurisdiction, the installation must conform to
American Society of Mechanical Engineers Safety Code for
Controls and Safety Devices for Automatically Fired Boilers,
ASME CSD-1. All boilers must conform to the latest edition
of the ASME Boiler and Pressure Vessel Code, Section II.
Where required by the authority having jurisdiction, the
installation must comply with the CSA International,
CAN/CGA-B149 and/or local codes. This appliance meets
the safe lighting performance criteria with the gas manifold
and control assembly provided, as specified in the ANSI
standards for gas-fired units, ANSI 221.13.




1.7 WARRANTY

. Factory warranty (shipped with unit) does not
apply to units improperly installed or improperly
operated.

. Factory warranty shall apply only when the

appliance is installed in accordance with local
plumbing and building codes, ordinances and
regulations, the printed instructions provided with it
and good industry practices.

. Excessive water hardness causing a lime build-
up in the stainless steel coils or tubes is not a fault
of the appliance and is not covered by warranty.
Consult the factory for recommendations for use in
hard water areas. (See Water Treatment and
Water Chemistry)

. Using or storing corrosive chemicals in the
vicinity of this appliance can rapidly attack the
stainless steel venting and heat exchanger coils
and voids warranty.

. Damage caused by freezing or dry firing  voids
warranty.

. This appliance is not to be used for temporary
heating of buildings under construction.

. The manufacturer shall NOT be held liable for any

personal injury or property damage due to ice
formation or the dislodging of ice from the vent
system or the vent termination

1.8 REMOVAL OF EXISTING APPLIANCE

When an existing appliance is removed from a common
venting system, the common venting system is likely to be
too large for proper venting of the appliances remaining
connected to it .At the time of removal of an existing
appliance, the following steps must be followed with each
appliance remaining connected to the common venting
system placed in operation, while the other appliances
remaining connected to the common venting system are
not in operation.

. Seal any unused openings in the common venting
system.
. Visually inspect the venting system for proper size

and horizontal pitch and determine that there is no
blockage, restriction, leakage, corrosion or other
deficiency, which could cause an unsafe condition.

. Insofar as is practical, close all building doors and
windows and all doors between the spaces in
which the appliances remaining connected to the
common venting system are located and other
spaces of the building. If applicable turn on the
clothes dryers and any appliances not connected
to the common venting system. Turn on any
exhaust fans, such as range hoods and bathroom
exhausts, so they will operate at maximum speed.
Do not operate a summer exhaust fan. Close
fireplace dampers.

. Place in operation the appliance being inspected.
Follow the lighting instructions. Adjust thermostat
so that appliance operates continuously.

. After it has been determined that each appliance
remaining connected to the common venting
system properly vents when tested as outlined
above, return doors, windows, exhaust fans,
fireplace dampers and any other gas-burning
appliance to their previous condition of use.

. Any improper operation of the common venting
system should be corrected so that the installation
conforms to the National Fuel Gas Code, ANSI
7223.1 and/or CAN/CGA B149, Installation Codes.
When resizing any portion of the common venting
system, the common venting system should be
resized to approach the minimum size as
determined using the appropriate tables in Part 11
of the National Fuel Gas Code, ANSI Z223.1 and
lor CAN/CGA B149, Installation Codes.

Heat exchanger surfaces and vent piping should be
checked every six months for deterioration and carbon
deposits. Remove all soot or other obstructions from the
chimney and flue, which might impede draft action. Replace
any damaged or deteriorated parts of the venting system.

A qualified service technician should follow this procedure
when inspecting and cleaning the heat exchanger and vent

pipe.

1) Turn off electrical power and main manual gas shut-off
and allow appliance to cool down.

2) Remove the vent pipe at connection to heat exchanger
and check heat exchanger and vent for obstruction and
clean as necessary.

3) Remove burner from appliance and carefully clean as
required. Never brush or wipe the knitted metal fiber
surface. Use a garden hose or gently wash under the
tap. Vacuum out any deposits found in the heat
exchanger.

CAUTION

Never use a pressure washer or compressed air to clean
the burner.

4) Reinstall parts removed in steps 2 and 3. Be sure that
vent pipe has proper pitch and is properly sealed.
Replace any damaged gasket or refractory. Tighten fan
flange mounting nuts to 3 ft-lb.

5) Restore electrical power and gas supply to appliance.

6) Place appliance in operation using lighting instructions
provided.

7) Confirm proper operation of all safety devices

8) Check for gas leaks and proper vent operation.

NOTE

Experience has shown that improper installation or
system design, rather than faulty equipment, is the
cause of most operating problems

1.9 BOILER/FURNACE ROOM OPERATING
CONDITION

*  Due to low jacket losses from the appliance,
temperatures in the vicinity of the boiler room may drop
significantly; supplemental heat is required to maintain
ambient temperature at minimum of 40°F.




1.10 LOCATION OF UNIT

Install this appliance in a clean, dry location with adequate
service clearance.

» Do not locate this appliance in an area where it will be
subject to freezing unless precautions are taken.
Radiant losses from the DynaMax are minimal and
should not be relied on to keep the appliance room
warm.

e The appliance should be located close to a floor drain
in an area where leakage from the appliance or
connections will not result in damage to the adjacent
area or to lower floors in the structure, it is
recommended that a suitable drain pan, adequately
drained, be installed under the unit. Under no
circumstances is the manufacturer to be held
responsible for water damage in connection with this
unit, or any of its components.

« If the appliance is installed above the level of the
building’s radiation system, a low water cut-off device
must be installed in the appliance outlet at a minimum
of 3 ft (LM) above the heat exchanger inlet/outlet
connections. Some local codes require the installation
of a low water cut-off on all systems

*  When placing the appliance be aware that a minimum
clearance of 24" must be provided at the front to allow
easy access to the heat exchanger. DynaMax wall
mount units do not require access through the sides
and could be placed adjacent to each other with zero
clearance. Floor mount units require access on the left
side.

*  The appliance must be installed so that the ignition
system components are protected from water
(dripping, spraying, etc.) during appliance operation
and service (circulator replacement, control
replacement, etc.)

« Appliances located in a residential garage and in
adjacent spaces that open to the garage and are not
part of the living space of a dwelling unit must be
installed so that all burners and burner ignition devices
have a minimum clearance of not less than 18" (46cm)
above the floor. The appliance must be located or
protected so that it is not subject to physical damage
by a moving vehicle.

» DO NOT install this appliance in any location where
gasoline or flammable vapors are likely to be present.

* Appliance must be installed on a level floor. Maintain
required clearances from combustible surfaces.

e The appliance designed for indoor installation (Indoor
Models) must be installed indoors where it is protected
from exposure to wind, rain and weather.

e The appliance designed for outdoor installation
(Outdoor Models) must be installed outdoors. For
outdoor installations, always consider the use of a
shelter such as a garden shed in lieu of direct
exposure of the appliance to the elements. The
additional protection afforded by the shelter will help to
minimize nuisance problems with electrical
connections and will allow easier servicing of the
appliance under severe weather conditions.

1.11 CLEARANCE FROM COMBUSTIBLE
MATERIAL

This appliance is suitable for alcove (a closet without a
door) installation with minimum clearances to combustibles
as follows:

Table 2: Wall Hung Clearance from Combustibles

Clearances from Combustibles

Wall Hung Floor Mount

Model Model
TOP: 0" 0"
SIDES: 0" 0"
REAR: 0" 12"
VENT (Vent Adapter): 1’ 1"
VENT (PVC/CPVC): 0" 0"

FRONT: OPEN OPEN

Figure 1: Wall Hung Clearance from Combustibles
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Figure 2: Floor Mount Clearance from Combustibles
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NOTE

Clearances from combustible construction are noted on the
appliance rating plate




Table 3: DynaMax Wall Hung Service Clearances

Input [BTU/h] Service Clea.rancej Inches (cm) '
Front Top Right Side Left Side Rear
80,000 24" (61cm) 0" (0 cm) 0" (0 cm) 0" (0 cm) 0” (0 cm)
100,000 24" (61cm) 0" (0 cm) 0" (0 cm) 0" (0 cm) 0” (0 cm)
150,000 24" (61cm) 0” (0 cm) 0” (0 cm) 0" (0 cm) 0" (0 cm)
200,000 24" (61cm) 0” (0 cm) 0” (0 cm) 0” (0 cm) 0" (0 cm)
250,000 24" (61cm) 0” (0 cm) 0” (0 cm) 0” (0 cm) 0" (0 cm)
Figure 3: DynaMax Wall Hung Model Dimensions
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Table 4: Appliance Dimensions and Specifications
Equivalent Length of Vent & Air
3 Intake Pipes at Recommended
. Dim. - - Water
Input Depth Dim. e Diameter, [in.] Conn [in] Gas Conn. At
[BTU/hr] "A" [in.] : Over 25' Over 15' ’ Boiler [in.] NPT
[in] , NPT
and up to and up to Up to 15
100 25'
80,000 16 1/2 12 3 3 2 1 1/2
100,000 16 1/2 12 3 3 2 1 1/2
150,000 16 1/2 12 3 3 2 1 1/2
200,000 231/2 19 3 3 2 1 1/2
250,000 231/2 19 3 3 2 11/4 1/2

Maintain minimum specified clearances for adequate operation. All installations must allow sufficient space for servicing the vent

connections, water pipe connections, circulating pump, bypass piping and other auxiliary equipment, as well as the appliance




Table 5: DynaMax Floor Mount Service Clearances

Input [BTU/hr] Service Clearance, Inches (cm)
Front Top Right Side Left Side Rear
200,000 12" (31cm) 24" (61cm) 0" (Ocm) 12" (31cm) 14” (36 cm)
250,000 12" (31cm) 24" (61cm) 0" (Ocm) 12" (31cm) 14" (36 cm)
299,000 12" (31cm) 24" (61cm) 0" (Ocm) 12" (31 cm) 14" (36cm)
399,000 12" (31cm) 24" (61cm) 0" (Ocm) 12" (31 cm) 14" (36 cm)
500,000 12" (31cm) 24" (61cm) 0" (Ocm) 12" (31 cm) 14” (36 cm)
600,000 12" (31cm) 24" (61cm) 0" (Ocm) 12" (31 cm) 14" (36cm)
750,000 12" (31cm) 24" (61cm) 0" (Ocm) 12" (31 cm) 14” (36 cm)

Figure 4: DynaMax Floor Mount Model Dimensions
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Table 6: Appliance Dimensions and Specifications
Equivalent Length of Vent & Air
3 Intake Pipes at Recommended
Model | Depth Dim. l?.g?' Diameter, [in.] C:Xﬁ‘g;] Gas Conn. At
"A"[in] fin ] Over25' | Over 15 NPT Boiler [in.] NPT
' andupto | andupto Up to 15'
100' 25'
200,000 36 22 3/4 3 3 2 1 1/2
250,000 36 22 3/4 3 3 2 11/4 1/2
299,000 47 1/8 34 7/8 4 3 3 11/4 3/4
399,000 47 1/8 34 7/8 4 3 3 11/4 1
500,000 47 1/8 34 7/8 4 3 3 11/2 1
600,000 - - 5 4* 4* 2 1
750,000 - - 5 4* 4* 2 1

* Up to 40 equivalent feet.

Maintain minimum specified clearances for adequate operation. All installations must allow sufficient space for servicing the vent
connections, water pipe connections, circulating pump, bypass piping and other auxiliary equipment, as well as the appliance



Figure 5: DynaMax Wall Hung Service Clearances
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PART 2  AIR INLET AND VENTING

!

It is extremely important to follow these venting
instructions carefully. Failure to do so can cause severe
personal injury, death or substantial property dama ge.

2.1 GENERAL VENTING GUIDE

¢ Single pipe vent with common air from room.

Figure 7: Vertical Venting Configuration
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The DynaMax Wall Hung is a category IV condensing
appliance, 97% efficient unit. The DynaMax Floor Mount is a
category Il condensing appliance, 97% efficient.

«  The DynaMax may be vented with manufactured
prefabricated UL/ ULC listed vents of AL29-4C or
316L stainless steel or with plastic vent certified to
UL/ ULC S636, such as, IPEX System 636 CVPC
or IPEX System 636 PVC or as permitted by local
jurisdictions.

¢« The DynaMax boiler must be vented and supplied
with combustion and ventilation air as described in
this section. Ensure that the venting and
combustion air supply complies with these
instructions regarding the vent system, air system,
and combustion air quality.

. Installations must be in accordance with Part 7,
“Venting of Equipment”, of the latest edition of the
National Fuel Gas Code, ANSI 7223.1 for US
installations or the latest edition of CAN/CGA
Standard B149 Installation Code for Gas Burning
Appliances and Equipment in Canada.

¢ The distance of the vent terminal from adjacent
buildings, windows that open and building openings
MUST comply with the latest edition of the National
Fuel Gas Code, ANSI 7223.1 for U.S. installations
or CAN/CGA Standard B149 Installation Code for
Canadian Installations.

¢ Vent connection is made directly to the flue outlet
opening on top of the unit for the wall mount unit
and at the back of the unit for floor mount. The
connection from the appliance vent to the stack
must be made as direct as possible. The first 3 feet
of vent from the appliance flue outlet must be
readily accessible for visual inspection.

* Vent connectors serving appliances vented by
natural draft shall not be connected into any portion
of a mechanical draft system operating under
positive pressure.

e Horizontal runs of vent pipe shall be securely
supported (approximately every 4 feet) to prevent
sagging and maintain a minimum upward slope of
Ya" per foot from the appliance to the vent terminal.

e The weight of the venting system must not rest on
the unit. Adequate support of the venting system
must be provided in compliance with local codes
and other applicable codes.

e All connections should be secured and sealed per
the vent manufacturer’'s specifications. When a
positive vent system is disconnected for any
reason, the flue must be reassembled and resealed
according to the vent manufacturer’s instructions.

« Do not use an existing chimney as a raceway if
another appliance or fireplace is vented through the
chimney.

e Inspect completed vent and air supply piping
thoroughly to ensure all connections are sealed and
are in compliance with the instructions provided and
satisfy requirements of all applicable codes.

NOTE

All vent pipes must be properly assembled and supported,
and the exhaust must be pitched a minimum of 1/4 inch per
foot back to the boiler. All components used to fabricate and
assemble the vent system are to originate from the same
supplier.

When determining equivalent inlet air and vent lengths of 3”
diameter add 3 to 5 feet for each 90° elbow and 2 to 3 feet
for each 45° elbow, depending on centerline radius of the
elbow.

Example: 30 feet of CPVC pipe + (3 x 5 feet) 90° elbows + (1
x 3 feet) 45° elbow = 48 equivalent feet of piping for
centerline radius of 1.5D, where D is the pipe diameter.

2.2 CATEGORY IV VENTING

A category IV appliance is individually vented through a
dedicated vent.

The DynaMax Wall Hung boilers/ water heaters shall only be
vented as a Category IV appliance. The DynaMax Floor
Mount appliances may be vented as a Category Il or IV
appliance.

Both Wall Hung and Floor Mount appliances shall be vented
using sealed positive vent suitable for a condensing
appliance with the following venting options:

1) Sidewall or rooftop termination where both the vent and
combustion air inlet air are in the same zone. The inlet
and vent terminals are to be installed with a minimum
12" separation distance between centerline of inlet and
centerline of exhaust. Refer to Fig. 8, 9, and 10 for
sidewall termination and Fig. 11 for rooftop termination.

2) Sidewall termination with vent and combustion air inlet
from separate zones.

3) Single Pipe thru wall or rooftop venting with combustion
air inlet from the boiler room.

NOTE

Vent Option 3 not recommended for R-2000 homes or
equivalent air tight construction.




Table 7: Maximum Flue Temperature for Various Vent

2.2.1 Approved Venting Materials Category IV 1)

1) PVC and CPVC (Chlorinated Polyvinyl Chloride)
Schedule 40 or 80 approved to ULC S636.
2) Manufactured prefabricated UL/ULC listed vent of AL29-

4C or 316L stainless steel. Use of 316L is limited to use in

applications where there is no possibility of contaminants
in the air such as refrigerants, chlorine etc.

3) PVC-DWYV approved to comply with ANSI/ASTM D2665
(US Jurisdictions ONLY when permitted).

4) CPVC Schedule 40 approved to comply with
ANSI/ASTM F441. (US Jurisdictions ONLY when
permitted).

Materials

Vent Material Maximum Flue Temperature [ °F]

The DynaMax Floor Mount boiler may be vented as a
Category Il appliance using sealed vent suitable for a
condensing appliance.

2.3.1 Approved Venting Materials Category Il

1) PVC and CPVC (Chlorinated Polyvinyl Choloride)
Schedule 40 or 80 approved to ULC S636.

2) Manufactured prefabricated UL/ULC listed vent of AL29-
4C or 316L stainless steel. Use of 316L is limited to use
in where there is no possibility of contaminants in the air
such as refrigerants, chlorine etc.

3) PVC-DWYV approved to comply with ANSI/ASTM D2665
(US Jurisdictions ONLY when permitted).

4) CPVC Schedule 40 approved to comply with
ANSI/ASTM F441. (US Jurisdictions ONLY when
permitted).

Air Inlet (Supply Air or Fresh Air) Piping

PVC 149
CPVC 194
AL29-4C 300+, limited only by rating of seals
316L Stainless - _
Steel 300+, limited only by rating of seals

Air Inlet (Supply Air or Fresh Air) Piping
e« PVC
¢ CPVC (Chlorinated Polyvinyl Chloride)
¢ ABS (Acrylonitrile-Butadiene-Styrene)
¢ Single wall, Galvanized
. Single wall, Stainless steel
¢ Single wall, Aluminium

Single wall air inlet pipes are to be insulated 5 feet from the
wall toward the interior of the building to minimize external
sweating.

The following air intake options shall be utilized:
¢ OQutside air sealed direct (vertical or horizontal)
¢ Qutside air ducted to jacket flange
¢ Indoor Air

Table 8: Required Vent and Air Inlet Diameters

Equivalent Length of Vent & Air Intake
Pipes at Recommended Diameter
[T Over 25' Over 15'
[BTS/hr] and up to and up to Up to 15'
100’ 25'
80,000 — " " "
250,000 3 3 2
299,000 4" 3" 3"
399,000 4" 3" 3"
500,000 4" 3" 3"
600,000 5” 4% 4
750,000 5” 4* 4

* Up to 40 equivalent feet
2.3 CATEGORY Il VENTING

A category Il appliance may be combined into a common
negative pressure venting system designed to ASHRAE
requirements using a proven vent sizing program. Vent
designs are to be certified by a qualified professional
designer acceptable to the authority having jurisdiction.

« PVC

e« CPVC (Chlorinated Polyvinyl Chloride)
e ABS (Acrylonitrile-Butadiene-Styrene)
e Single wall, Galvanized

e Single wall, Stainless steel

. Single wall, Aluminium

Single wall air inlet pipes are to be insulated 5 feet from the
wall toward the interior of the building to minimize external
sweating.

The following air intake options shall be utilized:
* Outside air sealed direct (vertical or horizontal)
e Outside air ducted to jacket flange
e Indoor Air

2.4 COMBINED COMBUSTION AIR INLET

Both the Category IV Wall Hung and Category Il Floor Mount
DynaMax appliances may be installed with a combined
combustion air inlet.

The combined combustion air inlet pipe sizing can be
calculated using the method shown below:

Equivalent pipe diameter = Sq Root [(d1)” + (d2)* + (dg)* + ...
+ (dn)z], where d, = individual pipe diameter

« Example: Find the equivalent pipe diameter of three
air inlet pipes, 3" (7.6cm), 3" (7.6cm) and 4”
(20.2cm)

Equivalent pipe diameter = Sq Root[(3)* + (3)° +
(4) = Sq Root(34) = 5.8”, select 6” (15.3cm)
equivalent diameter pipe.

The air inlet point for multiple boiler air inlets must be
provided with an exterior opening which has a free area
equal to or greater than the total area of all air inlet pipes
connected to the common air inlet. This exterior opening for
combustion air must connect directly to the outdoors. The
total length of the combined air inlet pipe must not exceed a
maximum of 100 equivalent feet (30.5m). Deduct the
restriction in an area provided by any screens, grills or
louvers installed in the common air inlet point. Screens, grills
or louvers installed in the common air inlet can reduce the
free area of the opening from 25 to 75% based on the
materials used. Calculate and compensate accordingly.



2.5 VENT TERMINATION AND AIR INLET
CLEARANCES

2.5.1 Sidewall Venting

¢ The first 3 feet (1m) of vent from the appliance flue
outlet must be readily accessible for inspection.

Figure 8: Vertical Configuration
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* Always check local codes for minimum distance above
ground or snow levels

Figure 9: Horizontal Configuration
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* Always check local codes for minimum distance above
ground or snow levels

Location of Vent Termination

1) The total length of vent piping must not exceed the
limits stated in Table 8.

2) The bottom of the vent terminal shall be located at
least 3 feet (1m) above grade or above normal
snow levels. In all cases the appliance shall be
installed in accordance with local codes

3) The DynaMax can vent up to 100 equivalent feet.
Elbows can range from 3 to 5 feet in equivalent
length depending on the centerline radius. Vent
sizes are 3" for Models 80 to 250 and 4” for Models
299 to 500 for equivalent vent lengths of up to 100'.

4) The vent outlet shall terminate at least 12" (0.30m)
away from any forced air inlet. The vent must be at
least 7 feet (2.15m) above grade when located
adjacent to public walkways due to normal
formation of water vapour in the combustion
process.

5) The vent outlet MUST NOT terminate below a
forced air inlet at any distance

6) The vent cannot terminate below grade. Position
the vent termination where vapours will not damage
walls or plants or may be otherwise objectionable.

7) The vent terminal shall not be installed closer than
3 feet (1m) from an inside corner of an L-shaped
structure, window well, stairwell, alcove, courtyard
or other recessed area as wind eddies could affect
boiler performance or cause recirculation.

8) DO NOT terminate closer than 4 feet (1.25m)
horizontally and vertically from any electric meter,
gas meter, regulator, relief valve, or other
equipment. In all cases local codes take
precedence

9) Position terminations so they are not likely to be
damaged by foreign objects, or exposed to a build-
up of debris.

10) The vent piping must terminate in an elbow pointed
outward or away from the air inlet.

11) Flue gas condensate can freeze on exterior walls or
on the vent cap. Frozen condensate on the vent
cap can result in a blocked flue condition. Keep the
vent cap/terminal clear of snow, ice, leaves, debris
etc. Some discolouration to exterior building
surfaces is to be expected. Adjacent brick or
masonry surfaces should be protected with a rust
resistant sheet metal plate.

12) Perform regularly scheduled inspections to ensure
that the vent terminal is unobstructed.

2.5.2 Sidewall Air Inlet

Figure 10: Sidewall Vent and Air Inlet Configuratio n
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* Please check local codes for minimum distance above
ground or snow levels

Location of a Sidewall Air Inlet Cap

1) The total length of piping for air inlet must not
exceed the limits stated in Table 8.

2) The point of termination for the sidewall air inlet cap
must be located a minimum of 12 inches (0.30m)
away from the flue gas termination, but never
above.

3) The air piping must terminate in a down-turned
elbow to avoid recirculation of flue products into the
inlet air stream.

4) DO NOT terminate closer than 4 feet (1.25m)
horizontally and vertically from any electric meter,
gas meter, regulator, relief valve, or other
equipment. In all cases local codes take
precedence

5) DO NOT terminate the air inlet in a window well,
stairwell, alcove, courtyard or other recessed area
as wind eddies could affect performance or cause
recirculation.

6) The air inlet cannot terminate below grade.

10



7

8)

Locate terminations so they are not likely to be
damaged by foreign objects, or exposed to build-up
of debris.

Perform regularly scheduled inspections to ensure
that the air inlet terminal is unobstructed.

Termination and Fittings

1)

2)

253

Insert the bird screens into the air inlet and exhaust
vent elbows that are provided with the boiler. Bird
screens are 3" (DM80-250) and 4" (DM299-500).
The air inlet opening must be at least 12 inches
(0.30m) away from (never above) the vent
termination and at least 3 feet (1m) above grade or
above normal maximum snow levels.

Vertical Direct Venting

Location of Vent Termination

1)

2)

3)

4)

5)

6)

7

8)

The total length of piping for venting must not
exceed the limits stated in Table 8.

Insert the bird screen that is provided with the boiler
into the vent termination opening. Bird screen sizes
are 3" (DM80-250) and 4" (DM299-500).

The vent piping must terminate in a 90° elbow if
plastic piping is used or in an approved vent cap if
using metal venting. The vent outlet must be at
least 1 foot away and 1 foot above from the air inlet
opening which must terminate in a double elbow
facing downwards.

The vertical termination must be a minimum of 3
feet (1m) above the point of exit.

A vertical termination less than 10 feet (3.05m) from
a parapet wall must be a minimum of 2 feet (0.61m)
higher than the parapet wall.

DO NOT terminate closer than 4 feet (1.25m)
horizontally and vertically from any electric meter,
gas meter, regulator, relief valve, or other
equipment. In all cases local codes take
precedence.

Position the air inlet and vent terminations so they
are not likely to be damaged by foreign objects, or
exposed to build-up of debris.

Perform regularly scheduled inspections to ensure
that the vent terminal is unobstructed.

Location of a Vertical Air Inlet Opening

1)

2)

3)

4)

5)

The total length of piping for inlet air must not
exceed the limits given in Table 8.

Insert the bird screen that is provided with the boiler
into the air inlet elbow. Bird screen sizes are 3"
(DM80-250) and 4" (DM299-500).

The air inlet consists of two 90° elbows installed at
the point of termination for the vertical air inlet pipe.
A 90° elbow and a 90° street elbow may be used to
make this assembly. If a straight piece of pipe is
used between the two elbows, it should not exceed
6” (0.15m) in length. The air inlet opening must be
at least 1 foot below the vent opening. The air
piping must be no further than 2 feet (0.6m) from
the center of the vent pipe. This arrangement
avoids exhaust gases from re-circulating into the
inlet air stream. Refer to Figure 10.

Air inlet must terminate at least 3 feet (1.0m) above
the roof or normal snow levels and at least 1 foot
(0.3m) below the vent termination.

Locate terminations so they are not likely to be
damaged by foreign objects or exposed to build-up
of debris.

6) Perform regularly scheduled inspections to ensure
that the air inlet terminal is unobstructed.

Figure 11: Vertical Direct Venting Configuration
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2.5.4 Length of Air Inlet Pipe

The maximum total length of the sidewall or vertical roof top
combustion air inlet pipe as installed from the appliance to
the air inlet cap must not exceed 100 equivalent feet (30.5m)
in length. Subtract 3 to 5 feet (1 to 1.5m) of equivalent length
depending on centerline radius for each 90° elbow installed
in the air inlet pipe system. Pressure drop in each 45° elbow
will be half as much, 2 to 3 feet (0.6 to 1.0m).

11



PART 3 GAS CONNECTION

Verify that the appliance is supplied with the type of gas
specified on the rating plate. Consult factory for installations
at high altitude.

3.1 GAS CONNECTION

«  Safe operation of unit requires properly sized gas supply
piping. See gas line sizing data.

* Gas pipe size may be larger than appliance connection.

« Installation of a union at the appliance gas line
connection is required for ease of service and removal
of the gas train.

¢ Install a manual main gas shutoff valve, outside of the
appliance gas connection as require by local codes.

e Atrap (drip leg) MUST be provided in the inlet gas
connection to the appliance.

«  Optional gas controls may require routing of bleeds and
vents to the atmosphere, outside the building when
required by local codes.

Table 9: Recommended Gas Pipe Size
Single Appliance Installation
(For distance from natural gas meter or propane second
stage regulator)

The appliance and its individual gas shut-off valve must be
disconnected from the supply piping when pressure testing
the gas supply piping at pressures above %2 PSI

Table 10: Gas Pressures at Inlet to Appliance

NATURAL
PROPANE GAS
Minimum (inches W.C.) 11 3
Maximum (inches W.C.) 11 14

Input 0-100 FT 101-200 FT 201-300 FT
'itfé'gg NAT. | LP. | NAT. | LP. | NAT. | L.P.
80 v | w Yy 1 1" v
100 vw | w 1" Y 17 Y
150 17 v | 1w | 1 1w | 1
200 1" v | 1w | 1 | awe | 1
250 | 1w | 17 [ 1we | 1 [ 1w [ 1w
209 | 1we | 1 [ 1w | 1w | 1w | 1w
309 | 1w | o1 [ 1w [ 1w | 20 [ 1w
500 | 1w | 1w | 2o [ 1w | o2¢ [ 1w
600 | 1w | 1w | 2o [ 1w | 2¢ [ 1w
750 2 | 1w |20 | 1w | 2w | 2o

3.2 GAS PIPING

All gas connections must be made with pipe joint compound
resistant to the action of liquefied petroleum and natural gas.
All piping must comply with local codes and ordinances.

3.3 INSTALL PIPING

e The gas line should be sufficient to handle the total
installed capacity. Verify pipe size with your gas
supplier.

« Use approved piping as per code free from burrs.

¢ Install a manual main gas shutoff valve at the appliance
gas inlet, outside of the appliance and before the gas
valve.

¢ Run pipe to the Appliance gas inlet.

« Install a sediment trap in the supply line to the Appliance

gas inlet.

e Apply a moderate amount of good quality pipe
compound.

e For LP gas, consult your LP gas supplier for expert
installation.

The gas supply line must be of adequate size to prevent
undue pressure drop and must never be smaller than the
size of the connection on the appliance. Sizing based on
Table 4 or 6 is recommended, depending on model.
Before operating the appliance, the complete gas train and
all connections must be tested using soap solution.

Verify that the appliance is supplied with the type of gas
specified on the rating plate. Heating values of local natural
gas are to be between 950 and 1010 Btu/ft®. Consult factory
if heating values are outside this range or if a gas with a
mixture of constituents is being used.

3.4 CHECKING GAS SUPPLY PRESSURE

e Turn the main power switch to “OFF” position.

e Shut off gas supply at the manual gas cock in the gas
piping to the appliance. If fuel supply is LP gas, shut off
gas supply at the tank.

« Remove the 1/8" hex plug from the gas pressure test
port located on the inlet gas supply connection at the
rear of the appliance. Install a fitting in the inlet pressure
tapping suitable to connect to a manometer or
magnahelic gauge. Range of scale should be 0 to 14
inch W.C. or greater to check inlet pressure

e Turn on gas supply at the field installed manual gas
cock; turn on LP gas at tank if required.

e Turn the power switch to “ON” position.

e Adjust the thermostat set point to call for heat.

* Observe the gas supply pressure as the burner fires at
100% of rated input. Supply pressure is to remain
stable.

e Ensure inlet pressure is within specified range. Minimum
and maximum gas supply pressures are specified in
Table 10.

e If gas pressure is out of range, contact the gas utility,
gas supplier, qualified installer or service agency to
determine necessary steps to provide proper gas
pressure to the control.

e If gas supply pressure is within normal range, proceed
to remove gas manometer and replace pressure tap
fittings in the gas piping to the appliance. Turn the
power switch to “OFF” position.

e Turn on gas supply at the manual valve; turn on LP gas
at tank if required.

e Turn the power switch to “ON” position.

*  Adjust the thermostat temperature set point to the
desired water temperature so the appliance will call for
heat.

*  Check appliance performance by cycling the system
while you observe burner response. The burner should
ignite promptly. Flame profile should be stable, see
section 11.2, Visually Check Main Burner Flames. Turn
system off and allow burner to cool, then cycle burner
again to ensure proper ignition and flame
characteristics.
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IMPORTANT
Upon completion of initial installation or following any repair
work on the gas system, leak test all gas connections with a
soap solution while the main burner is firing. Immediately

repair any leak found in the gas train or related components.

DO NOT operate an appliance with a leak in the gas train,
valves or related gas piping.

3.5 AIR/GAS RATIO VALVE

The main gas valve supplying gas to the burner on this
appliance utilizes a servo pressure regulator providing a
slow opening, fast closing safety shut off and air/gas ratio
control for the gas combustion process. The valve is a 1:1
negative pressure gas valve. The valve performs the
functions of a pressure regulator, safety shutoff, and air/gas

ratio control. Full closing of the valve seat occurs in less than

0.8 seconds when the valve is de-energized. Operation of
the gas valve in combination with the combustion air fan

allows the burner input rate to vary from 20% to 100% based
on temperature demand. The inlet gas supply pressure must

be maintained within the specified minimum and maximum
pressures.

The air/gas ratio is preset at the factory and adjustment is
not usually required if gas supply pressure is maintained
within the specified range.

There are no serviceable parts on the air/gas ratio valve
control.

Figure 12: DynaMax 80 — 150 1:1 Air/Gas Ratio Contr ol
Valve

HIGH FIRE ADJUSTMENT:
USE THROTTLE SCREW
LOCATED ON VENTURI

LOW FIRE
ADJUSTMENT
SCREW
(TORX 40, CLOCKWISE
INCREASES CO;)
GAS INLET

Figure 13: DynaMax 200 — 399 1:1 Air/Gas Ratio Cont rol
Valve

LOW-FIRE AIRIGAS

RATIO ADJUSTMENT

(USE T-40 FOR ADJUSTMENT,
CLOCKWISE INCREASES CO03)

S~ GAS VALVE

;‘j..,;,' g HIGH-FIRE AIRIGAS
RATIO ADJUSTMENT
(USE FLAT HEAD SCREWDRIVER
FOR ADJUSTMENT,
CLOCKWISE INCREASES CO;)

Figure 14: DynaMax 500 — 750 1:1 Air/Gas Ratio Cont rol
Valve

LIFT TOP COVER TO ACCESS
HIGH FIRE AIR/GAS RATIO
ADJUSTMENT
(USE 3mm_ ALLEN KEY FOR ADJUSTMENT
CLOCKWISE INCREASES CO,}

LOW FIRE AIR/GAS
RATIO ADJUSTMENT,
USE FLAT HEAD
SCREWDRIVER
¥ e FOR ADJUSTMENT
S (CLOCKWISE INCREASES CO;)
o B T GASINLET

7’

3.6 BURNER
Figure 15: DynaMax Burner

This appliance uses a single cylindrical burner installed
horizontally into the cavity located in the center of the heat
exchanger. There is a unique burner for each one of the
DynaMax models.

Burners may NOT be interchanged between different Btu/hr
input models. The burner consists of a round mounting
flange welded to a ported stainless steel mixing tube. This
stainless steel tube is covered with a close fitting, knitted
stainless steel metal fiber alloy material that forms the burner
outer surface. The burner is setup to operate in blue mode
and infrared operating condition should be avoided. Infrared
operation will occur only if air to gas adjustments is incorrect.
If infrared operation is noted the cause must be corrected.

The burner should be removed for inspection and cleaning
on an annual basis. An appliance installed in a dust or dirt
contaminated environment will require inspection and
cleaning on a more frequent schedule. The fan assisted
combustion process may force airborne dust and dirt
contaminants, contained in the combustion air, into the
burner. With sustained operation, non-combustible
contaminants may reduce burner surface area, reduce
burner input or cause non-warrantable damage to the
burner.

Airborne contaminants such as dust, dirt, concrete dust or
dry wall dust can be drawn into the burner with the
combustion air and block the burner surface area. DO NOT
operate this appliance during construction.

The spark igniter and flame sensor are removable from the
combustion chamber mounting door without removing the
burner assembly.

Never use an open flame (match, lighter, etc.)toc  heck
gas connections.
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PART 4 WATER CONNECTION

¢ Check all applicable local heating, plumbing and
building safety codes before proceeding.

« If the appliance is installed above radiation level it must
be provided with a low water cut-off device at the time of
appliance installation (available from Camus). Some
local codes require the installation of a low water cut-off
on all systems.

e A pressure relief valve is supplied with each DynaMax.
The relief valve must be mounted in a vertical position
and piped to the floor in a manner acceptable to the
enforcing authority.

«  Be sure to provide unions and gate valves at inlet and
outlet to the appliance so that it can be easily isolated
for service.

e On combination heaters a flow setter valve at the
appliance outlet facilitates setting of the desired outlet
temperature at high fire. Refer to Section 12.9 Domestic
Hot Water with Plate Heat Exchanger for more details

«  This appliance is a low mass stainless steel tube design
which provides for instant heat transfer. All appliances
are supplied with an internal suitable specific pump
mounted in place. When replacing the pump, replace
with one of equal or better-performance.

« An air vent is supplied on the heat exchanger header to
eliminate trapped air. Install venting devices at high
points in the system as well to eliminate trapped air in
the piping.

« Use suitable pipe hangers or floor stands to support the
weight of all water and gas piping.

*  The DynaMax must be installed so that the gas ignition
system components are protected from water (dripping,
spraying, rain, etc.) during appliance operation and
service (circulator replacement, control replacement,
etc.)

4.1 FREEZE PROTECTION OUTDOOR
INSTALLATION

* Appliance installations are not recommended outdoors
or in areas where danger of freezing exists unless
precautions are taken. Maintaining a mixture of 70%
water and 30% propylene glycol is the preferred method
of freeze protection in hydronic systems. DO NOT
exceed a mixture of 50/50. This mixture will protect the
appliance to approximately -35°F (-37°C).

«  For Outdoor installations a snow screen should be
installed to prevent snow and ice accumulation around
the appliance. Regular inspections should be made to
ensure that air inlet and vent are free of snow and ice.
Always consider the use of a shelter such as a garden
shed in lieu of direct exposure of the appliance to the
elements. The additional protection afforded by the
shelter will help to minimize nuisance problems with
electrical connections and will allow easier servicing of
the appliance under severe weather conditions.

4.2 WARNING REGARDING CHILLED WATER
SYSTEMS

When an appliance is connected to an air conditioning
system where the same water is used for heating and
cooling, the chiller must be piped in parallel with the
appliance. Appropriate flow control valves; manual or
motorized must be provided to prevent the chilled water from
entering the appliance.

Figure 16: Chilled Water System

Supply

. ~+——<— Chiller
Boiler
]

4.3 INLET AND OUTLET CONNECTIONS

Retun

e All water connections must meet American National
Standard Pipe Threads (NPT).

e For ease of service, install unions on inlet and outlet of
the appliance. The connection to the appliance marked
“Inlet” on the header should be used for return from the
system. The connection on the header marked “Outlet”
is to be connected to the supply side of the system.

4.4 MINIMUM PIPE SIZE REQUIREMENTS

Minimum water pipe connections are as follows for DynaMax
single unit installations. The equivalent number of straight
feet of pipe for each valve and fitting in the connecting piping
must be considered to properly arrive at the total equivalent
feet of straight pipe in the field installed piping to the
appliance. Consult factory if longer piping distances are
required for a specific application. It is recommended to use
copper piping for all system piping to reduce the possibility of
the formation of deposits, which may result in heat
exchanger starvation.

Table 11: Minimal System Pipe Size

Water
Size,
Input, NPT
Btu/Hr [in.]
80,000 1
100,000 1
150,000 1

200,000 11/4
250,000 11/4
299,000 11/2

399,000 2
500,000 2
600,000 2
750,000 2
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4.5 HEAT EXCHANGER

This appliance uses precision formed stainless steel tubing
to maximize the heat transfer process and achieve 97%
steady-state efficiency. This heat exchanger is designed to
withstand 160 PSIG working pressure.

A factory installed circulating pump ensures proper water
flow during burner operation and creates enough velocity
inside the stainless steel tubes and headers that prevents
scaling.

4.6 LOW WATER TEMPERATURE SYSTEMS

In applications where the heating system requires supply
water temperatures below 110F, connections may be made
directly to the DynaMax. At incoming temperatures of 80°F
or lower the DynaMax achieves maximum efficiency. Inlet
temperatures must not drop below 40°F to prevent freezing.

4.7 PIPING ARRANGEMENTS

The DynaMax boiler when configured as a hydronic heating
boiler allows for 4 modes of operation. For more details on
each of the operating modes refer to section 6.3 Central
Heating Modes.

47.1 Field Supplied Components
1) Boiler system piping

Boiler system piping MUST be sized according to
Tables 4 and 6. Reducing the pipe size can restrict
the flow rate through the boiler, causing boiler
damage and will void the manufacturer’'s warranty.

2) Isolation Valves

Use only full port ball valves. Failure to supply full
port ball valves may result in reduced flow rate
through the boiler, causing boiler damage and wiill
void the manufacturer’'s warranty.

3) Anti-Scald Mixing Valve

An anti-scaled mixing valve is recommended when
DHW storage is above 120°F.

4) Unions
Recommended for ease of serviceability.
5) System Temperature Sensor

A system temperature sensor is to be installed in
the main header at a point to detect controlled
temperature and where it will not lead to short-
cycling of the boiler.

An instantaneous water heater is designed to deliver hot
water without the use of a storage tank. It is suitable for
applications with variable load such as restaurants,
condominiums, apartments and motels and typically used in
conjunction with tempering valves to achieve temperature
control.

Table 12: Flow and Pressure Drop at a Given
Temperature Rise (Hydronic Heating)

30 F (16.7 C) 35 F (19.4 )

Input, Temp Rise Temp Rise
BWHr 1" ysepm USGPM.

(min. AP Ft. (min. AP Ft.

flow) flow)
80,000 5.0 8.2 4.3 6.2
100,000 6.3 12.3 5.4 9.4
150,000 9.5 10.4 8.1 7.8
200,000 12.6 7.2 10.8 5.8
250,000 15.8 11.5 13.5 8.7
299,000 18.9 9.3 16.2 7.0
399,000 25.2 8.4 21.6 6.3
500,000 31.5 9.2 27.0 6.9
600,000 35.9 14.7 32.0 11.8
750,000 44.9 22.1 40.0 14.4

Table 13: Flow and Pressure Drop at a Given
Temperature Rise (DHW)

20 ¥ (11.1 C)
Input, Temp Rise
Btu/Hr
USGPM

(min. AP Ft.

flow)
80,000 7.5 11.5
100,000 9.4 26.9
150,000 14.0 27.8
200,000 19.2 25.9
250,000 23.5 28.3
299,000 28.8 25.8
399,000 38.4 23.9
500,000 48.6 29.4
600,000 57.6 34.2
750,000 70.4 40.0
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4.8 FLOW PROVING DEVICE (wall mount
models only)

Figure 17: Flow Proving Device

The flow proving device is designed to detect when flow is
present. This is done by detecting the amount of current
(amperes) that exists in the neutral wire from the pump.
When the current becomes too low a flow switch error is
displayed indicating a lack of water inside the boiler.

4.9 WATER FLOW SWITCH (shipped loose,
floor mount models only)

A water flow switch is shipped loose and is to be installed in
the outlet piping on all heating boilers and hot water supply
boilers. The flow switch is to be installed in a horizontal run
of pipe in order to provide effective contact. The flow switch
is to be wired into the DynaMax terminal board labelled
‘Flow/LWCO'.

410 LOW WATER CUTOFF (If Equipped)

If this boiler is installed above radiation level, a low water
cut-off device must be installed at the time of boiler
installation. Some local codes require the installation of a low
water cut-off on all systems. Electronic low water cut-offs are
available as a factory supplied option on all models. Low
water cut-offs should be tested every six months. The
normally open switch contact of the low water cutoff is to be
wired in series with the flow switch. This can be wired into
the DynaMax terminal labelled ‘Flow/LWCO'.

411  RELIEF VALVE

This appliance is supplied with a relief valve sized in
accordance with ASME Boiler and Pressure Vessel Code,
Section IV (“Heating Boilers”). This component is shipped
loose. The relief valve is to be installed in the vertical
position and mounted in the outlet. No valve is to be placed
between the relief valve, and the appliance. To prevent
water damage, the discharge from the relief valve shall be
piped to a suitable floor drain for disposal when relief occurs.
No reducing couplings or other restrictions shall be installed
in the discharge line. The discharge line shall allow complete
drainage of the valve and line. Relief valves should be
manually operated at least once a year.

CAUTION
Avoid contact with hot discharge water

CAUTION
Remove jumper when connecting to 24 VAC circuit.

Figure 18: Low Water Cut Off Electrical Connections

WARNING: Be sure to
remove the jumper between
H and P1

- Connection detail for placing L.W.C.O.
in 24V circuit, in series with flow switch.

FLOW SWITCH

From Pin %0 on DynaMax —|Z—I7 77777777777777

Terminal Board

To Pin #10 on Dynalax
Terminal Board

412 DHW TUNING VALVE (combination models
only)

A DHW tuning valve is provided with DynaMax combination
models. In cases where flow control is not possible by the
end user the DHW tuning valve is designed to act as a
maximum flow controller. The tuning valve is designed to
provide the correct amount of hot water for each particular
DynaMax model and application. Refer to section 12.9
Domestic Hot Water with Plate Heat Exchanger for further
details.
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PART S5 ELECTRICAL &

CONTROLS
L Aopaneer

IT IS EXTREMELY IMPORTANT THAT THIS UNIT BE
PROPERLY GROUNDED!

51 ELECTRICAL CONECTIONS

Minimum 120VAC 60Hz single phase (15A circuit) is
required for the DynaMax models DM-080 through DM-750.
The appliance, when installed, must be electrically grounded
in accordance with the requirements of the authority having
jurisdiction or in the absence of such requirements, with the
latest edition of the National Electrical Code ANSI/NFPA No.
70. When the unit is installed in Canada, it must conform to
the Canadian Electrical Code, C22.1, Part 1 and/or local
Electrical Codes.

« All wiring between the appliance and field installed
devices shall be made with wire having minimum 220°F
(105°C) rating.

« Line voltage wire exterior to the appliance must be
enclosed in approved conduit or approved metal clad
cable.

e The pump must run continuously when appliance is
being fired.

¢« To avoid serious damage, DO NOT ENERGIZE the
appliance until the system is full of water. Ensure that all
air is removed from the pump housing and piping before
beginning initial operation. Serious damage may result if
the appliance is operated without proper flow.

*  Provide the appliance with proper overload protection.

5.2 HIGH LIMIT

A manual reset fail-safe high limit aqua-stat control is located
at the back of the appliance and the control bulb is installed
in a dry well in the heat exchanger outlet. The setting of this
control limits maximum discharge water temperature to
210°F. The temperature of the outlet water in the heat
exchanger must drop a minimum of 30F (16.7<C) belo w the
setting of the high limit control before the reset function can
be activated.

5.3 DYNAMAX CONTROLLER

This appliance uses a direct spark ignition control system.
The operation of the DynaMax Controller for the direct spark
igniter proves the presence of main flame using a flame
sensor proof current (1.25pA). A status point alarm of Flame
Fail will be displayed on the main panel if the boiler fails to
light after three (3) ignition attempts.

Figure 19: DynaMax Controller

Table 14: Connector Description

Connector Connector Description
Provides 120V to the DynaMax
J2 Controller
J6 3-Way Diverter Valve
J7 On-Board Pump
J13 High-Limit, Gas Valve, Flame Sensor
J9 Fan Power, Fan Modulation
J5 Various Sensors
J16 Safety Switches
J12 Spark Return Signal
T2 Spark Igniter
F1 3.15A Fuse

5.3.1 SERVICE PARTS

The DynaMax Controller is not repairable. Any modification
or repairs will invalidate the warranty and may create
hazardous conditions that result in property damage,
personal injury, fire, explosion and/or toxic gases. A faulty
direct spark igniter MUST be replaced with a new factory
part. DO NOT use general purpose field replacement parts.
Each appliance has one DynaMax Controller, one direct
spark igniter and one flame sensor. A list of recommended
spare parts is available.

53.2 IGNITION MODULE LOCKOUT FUNCTIONS

The DynaMax Controller may lockout in either a hard lockout
condition requiring pushing the reset button to recycle the
control for a CSD1 requirement or a soft lockout condition. A
typical hard lockout fault for the DynaMax Controller is a 3
trial ignition failure condition. Pushing the reset button on the
control panel is the only way to reset the DynaMax Controller
that is in a hard lockout condition. The reset button is active
after the post purge cycle when there is a lockout condition
as indicated by the LCD display. Turning the main power
“OFF” and then “ON” or cycling the thermostat will not reset
a hard lockout condition. Wait five seconds after turning on
the main power before pushing the RESET button when the
DynaMax Controller is in a hard lockout condition. Wait for
the status LCD display to refresh indicating that the
DynaMax Controller is ready before releasing the reset
button.

The DynaMax Controller will go into a soft lockout condition,
for example, if the supply sensor is disconnected, flow
switch, LWCO or air switch are not made. If the fault is not
corrected, the boiler will stay in the soft lockout state. Once
the fault is corrected, the boiler will automatically return to
normal operating state

5.4 ERROR TABLE

The following tables provide a description of all the possible
errors with the DynaMax boiler. Errors can be divided into
two groups. Soft lockout errors (will disappear when error is
gone) and hard lockout errors (can only be reset by the
RESET button). A soft lockout error will be indicated with an
‘E’ prior to the error number. A hard lockout lockout error will
be indicated with an ‘A’ prior to error number.

When the control is in error the pump will be running. This is
done to prevent the freezing of the central heating circuit
when the boiler is in error during the winter period. For some
non volatile lockouts the pump will not be running, see table
below for more details.
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5.4.1  Hard Lockout ‘A’ Codes 5.4.2  Soft Lockout ‘E’ Codes
Table 15: Lockout Codes Table 16: Blocking Codes
‘A Error Int Description ‘E’ Error Int Description
code nr. code nr.
Three unsuccessful Supply sensor not
01 IGNIT_ERROR 1 ignition attempts in a 01 | T_SUPPLY_OPEN 51 connected
row
Three times flame 02 | TINLET_OPEN 52 ::rg)lﬁ;:?esdor ot
02 | TOO_MANY_FLAME |, | |ost during one DHW sensor not
_FAILURES demand 04 | T_DHW_OPEN 55 connected
T_MAX_LOCK_ERR Overheat stat is open T SUPPLY_SHORTE Supply sensor
03 18 11 — - 59
OR D shorted
Problems with gas 12 | T_INLET_SHORTED 60 | Inlet sensor shorted
04 | GV RELAY ERROR 5 | valverelay = internal 13 | T STACK SHORTED | 65 [ Stack sensor shorted
- - hardware e)rror (pump 14 | T DHW SHORTED 63 | DHW sensor shorted
not running Problems reading
Problems with safety 19 | E2PROM_READ_ERR | | fom or writing to
o5 | SAFETY_RELAY ER | | relay =internal OR e2prom
ROR hardware error (pump 20 | FLAME_ERROR 2 36_| False flame detected
not running) Phase and neutral of
09 [ RAM_ERROR 9 Internal software error 21 | PHASE ERROR 44 | mains supply are
09 FLAG_BYTE_INTEG 27 Internal software error - reversed
RITY_ERROR No earth connected
09 [ AD_HI_CPL_ERROR 28 | Internal software error 22 | WD 50HZ ERROR 43 | orinternal hardware
09 AD_LO_CPL_ERRO 29 Internal software error - - error
R Mains frequency
09 REGISTER ERROR 30 Internal software error 23 NET_FREQ_ERROR 45 | differs more than 2%
10 E2PROM ERROR 12 Np communication from 60Hz _
- with E2prom o4 | FAULTY_EARTH_ER 46 | Earth connection is
WRONG_EEPROM_ Contents of e2prom is ROR not ok
12 10
SIGNATURE not up-to-date STAC o Stack sensor >
13 STATE_ERROR 13 | Internal software error 30 RTA K_TEMP_ERR 35 | setpoint + diff. See
14 ROM ERROR 14 | Internal software error chapter
15 15MS XRL ERROR 16 | Internal software error 31 LOW_WATER_CUTO 37 Water pressure is to
16 20MS XRL ERROR 22 | Internal software error FF_ERROR low
18 STACK_ERROR 19 | Internal s_oftware error 32 INLET TEMP_ERROR | 40 Intlet tempsrature is
FLAME OUT TOO Flame still present 10 above 90 degrees
19 LATE ERROR - 20 | sec. after closing the 42 WD_COMMUNICATIO 47 Internal hardware
- gas valve N_ERROR error
Flame detected just 45 REFHI_TOO_LO_ERR 31 Internal hardware
20 FLAME_ERROR_1 21 | before gas valve OR error
opened 46 REFHI_TOO_HI_ERR 32 Internal hardware
32 41MS_ERROR 23 | Internal software error OR error
Fan deviation more 47 REFLO_TOO_LO_ER 33 Internal hardware
than 300 rpm longer ROR error
33 FAN_ERROR 8 than 1 minute (when 48 REFLO_TOO_HI_ERR 34 Internal hardware
fan speed > 4200 rpm OR error
this error is ignored) RESET BUTTON_ER Reset button pressed
o 51 66 more than 7 times
To eliminate the hard lockout error, ROR within one minute.
1) Wait until the boiler has completed it's post-purge Appliance selection
cycle, if applicable code and resistor do
2) Press and hold the ‘RESET” button until the display APPLIANCE_SELECTI C
) 52 48 | not match. This is
reverts back to showing the supply temperature ON_ERROR only checked at
3) Release the RESET button, the hard lockout has

been cleared

startup.
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PART 6 CONTROL PANEL
6.1  DYNAMAX CONTROLLER

The appliance is provided with a operator interface panel at
the front. On a DynaMax Wall Hung boiler the DynaMax
Controller can be accessed by removing the upper stainless
steel jacket and the lower black sheetmetal jacket which are
each held on by two (2) screws. On a DynaMax Floor Mount
boiler the DynaMax Controller can be accessed by carefully
lifting off the black-coloured Top cover which is held on by
four (4) snap lock fasteners.

The Boiler Temperature Controller (BTC) for this appliance is

a proprietary Camus DynaMax Controller. It initiates the local

call for heat and sets the target supply (appliance outlet)

water temperature. This controller accommodates heating
and domestic water control with multiple modes of operation
which provide set point as well as reset control. It provides
the following:

* Readings of inlet and outlet water temperatures, stack
temperatures, domestic hot water temperature, flame
current, status of heater operation, etc.

e Operation as an auto reset limit.

«  Operation as a control for discharge water temperature.

¢ Optional tank mounted sensor used in conjunction with
outlet sensor for domestic hot water.

e Adjustable target temperature

« Display of run hours for maintenance purposes. Counter
displays run time up to 10,000 hours. Pressing the
RESET button will reset the counter.

¢ Molex, Stocko and AMP connectors for ease of service.

«  Error message display.

6.2 SETTING THE DYNAMAX CONTROLLER

Press the MENU button and then select the desired setting
using the PREVIOUS and NEXT Buttons. When the desired
setting is satisfied press the ENTER key and this will save
the last setting. In normal operating mode the inlet
temperature, outlet temperature, and ON hours can be
viewed by pressing the PREVIOUS and NEXT key. After
checking the settings allow the control to return to normal
operation on its own.

6.3 CENTRAL HEATING MODES

Mode 0: Central Heating Without Outdoor Reset

In this mode no outdoor sensor is needed. If the room
thermostat closes, the pump is switched on. If the supply
temperature drops below the hysterese and central heating
setpoint (ch_setpoint) temperature the burner is switched on.
Burner power is PID regulated between (Supply
temperature) T-supply and ch_setpoint. When supply
temperature is above the ch_setpoint + hysterese the burner
is switched off.

If the room thermostat opens the burner is switched off and
the pump runs on for post pump (default: 30 sec).

Mode 1: Central Heating with Outdoor Reset and Thermostat
Control

This mode will only function when an outdoor sensor is
connected. The setpoint is calculated depending on the
outdoor temperature and the burner will react on the room
thermostat. The central heating setpoint is calculated as
follows:

ch_setpoint =t_day_ref + [(20 — T_outdoor) * Slope]

t_day_ref is the reference temperature for central heating
setpoint when T_outdoor is 68°F (20°C). T_day_ref is a user
settable parameter.

The Slope can be set via the menu between 0.1 to 5.0 with
steps of 0.1.

The calculated central heating setpoint is limited between
90°F (32°C) and 185°F (85°C).

The outdoor temperature used for the central heating
setpoint calculation is measured once a minute and
averaged with the previous measurement. This is done to
avoid drastic changes to the boiler when outdoor
temperature fluctuates rapidly.

Functionality remains the same as Mode 0 apart from the
calculated setpoint.

Figure 20: Programmable Ch_setpoint curve
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Mode 2: Central Heating with Outdoor Reset

An outdoor sensor must be connected for this mode to
function properly. The central heating setpoint is calculated
the same way as Mode 1. However, the demand does not
depend on a room thermostat but instead on the outdoor
temperature and the weather compensation setpoint. When
the outdoor temperature is below this weather setpoint a
central heating demand is created.

Overnight an input signal from a room thermostat (RT) can
lower the ch_setpoint. When the RT input closes the
ch_setpoint will also be lowered with t_night_reduction.
Therefore, RT input does not directly influence central
heating demand.
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Mode 3: Central Heating with Constant Temperature Loop

No outdoor sensor is needed. The supply temperature is
kept constantly at the setpoint temperature. The burner is
controlled in a similar way as Mode 0. When the room
thermostat contact closes the ch_setpoint will be decreased
with t_night_reduction. The pump is always on in this
condition.

6.4 DOMESTIC HOT WATER MODES

Mode 0: Disables Domestic Hot Water
No domestic hot water is available; therefore the DHW
sensor is not supplied.

Mode 1: DHW Storage Tank with Temperature Sensor

The DHW temperature in the tank is measured with a
storage tank sensor and set with parameter dhw_setpoint.
When the DHW sensor drops below ‘DHW_setpoint —
dhw_hyst_down’ the control detects a demand for the
storage tank and activates the pump. If the DHW
temperature continues to drop the ignition sequence will
begin. When the burner is lit the load is PID-modulated so
the supply is regulated towards DHW _setpoint. The burner
will fire at steady-state or it shall shut off if the storage tank
sensor is greater than ‘DHW_setpoint + dhw_hyst_up’. The
on-board pump will continue to circulate until the
dhw_post_pump_ period timer is satisfied.

With this mode of operation a Pre-Heat function is
implemented in the algorithm. If the storage tank sensor
detects that the temperature is below DHW _setpoint —

DHW _store_hold_warm the boiler will initiate the ignition
sequence and the burner will fire at minimum fire until the
storage tank sensor temperature is satisfies DHW_setpoint +
DHW_store_hyst_up.

The anti-freeze monitor on each boiler will monitor the inlet
water temperature and when it drops below 50°F (10°C) it
will bring on the pump to prevent freezing of the heat
exchanger.

Mode 2: DHW Storage Tank with Aguastat

When the aquastat closes the control detects a demand for
the storage tank and starts the pump. Operation of Mode 2 is
identical to the operation of Mode 1, but an aquastat
replaces the use of a sensor in the storage tank. The Pre-
Heat algorithm is not available in this mode of operation

Mode 4: Combination Boiler using Plate Heat Exchanger and
DHW Temperature Sensor

In this configuration the boiler can be used for space heating
and indirect domestic hot water. Camus supplies an on-
board brazed plate heat exchanger, a pump and a 3-way
diverter valve.

When a heat demand is detected the pump will run and the
3-way diverter valve switches over to the hydronic heating
loop. The pump continues to run until the ‘post pump CH
period’ is complete after cycling through a heat demand
cycle. When there is no heat demand the pump will turn off
Individually controlled zone pumps will draw hot water from
the manifold and return from the zone to the manifold.

The temperature of the water leaving the plate heat
exchanger is constantly monitored and when it drops below
‘dhw_setpoint — dhw_hyst_down’, the on-board pump
activates to satisfy a demand for DHW and the 3-way
diverter valve switches over to DHW demand. If a central
heating demand is present when a DHW demand occurs,
the heating demand will be interrupted resulting in domestic
hot water priority. The 3-way valve shall switch over from
hydronic heating to DHW demand and the boiler will
continue to function in this state until DHW demand ends. If
hydronic demand is still present after DHW demand ends the
3-way valve switches over to hydronic heating. This results
in zero lag, as the burner does not restart when switching
between hydronic heating and DHW demand.

Due to the use of a plate heat exchanger a Pre-Heat function
is implemented in the algorithm. This ensures the plate is
always warm and prevents the user from receiving an initial
blast of cold water when they first turn on the tap. The Pre-
Heat function is enabled after 2 minutes of burner shut off. If
the DHW sensor detects that the temperature is below ‘Pre
Heat setpoint — pre heat hyst down’ the boiler will initiate the
ignition sequence and the burner will fire at minimum fire
until the DHW sensor temperature is equal to the Pre Heat
Setpoint. The Pre Heat function will only activate when a
DHW demand is non-existant.

The anti-freeze monitor on each boiler will monitor the inlet
water temperature and when it drops below 50°F (10°C) the
pump will be activated to prevent the heat exchanger from
freezing.
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PART 7 COMPONENTS
7.1 DIRECT SPARK IGNITER

The direct spark igniter is inserted directly through the
combustion chamber front door and held in place by two torx
screws. Care must be taken when removing and/or installing
the igniter. Always remove the igniter prior to removing the
fan assembly for inspection of the burner and heat
exchanger.

Figure 21: Direct Spark Igniter

During a trial for ignition sequence a properly operating
igniter will generate a continuous spark with a 3/16” spark
gap. Itis recommended to clean the direct spark igniter
using steel wool as required. DO NOT use sandpaper or grit-
cloth since this will contaminate the metal surface.

7.2 FLAME SENSOR

The flame sensor is inserted directly through the combustion
chamber front door and is screwed into the combustion
chamber front door. Care must be taken, when installing the
flame sensor, to align it perpendicular to the fan flange and
parallel to the burner tube and not to over tighten.

Figure 22: Flame Sensor

The ignition module relies on the flame sensor to provide a
flame rectification signal. Oxide deposits, improper
placement or damaged ceramic insulator will result in
insufficient signal leading to ignition module lock out. For
proper operation minimum 1.25 pA DC must be fed back to
the module. Oxide deposit on the sensor rod must be
removed with steel-wool. DO NOT use sand-paper since this
will contaminate the metal surface.

7.3 COMBUSTION AIR FAN

DynaMax uses a modulating air fan to provide combustible
air/gas mix to the burner and push the products of
combustion through the heat exchanger and venting system.
The fan assembly consists of a sealed housing and fan
wheel constructed from spark resistant cast aluminium. The
fan is operated by a fully enclosed 120 VAC, Single-Phase
EC/DC electric motor. The fan housing and motor assembly
is fully sealed and SHOULD NOT be field serviced. The
power draw of the motor is proportional to the modulated gas
input rate of the appliance.

7.4 GAS VALVE

Figure 23: Venturi and Gas Valve Arrangement

The Gas Valve supplied with the DynaMax boiler is a
combined valve/venturi assembly. A servo pressure
regulator is incorporated into the gas valve to provide stable
gas supply. Pressure taps are provided to check inlet and
outlet gas pressures. An internal fine mesh screen is
incorporated in the inlet of the gas valve to prevent debris
from entering the combustion chamber. Gas valves all
factory set at low and high fire and modulates to maintain
combustion characteristics across the full operating range.

7.5 OUTER JACKET

The outer jacket assembly is constructed from mirror finish
stainless steel. This ensures a long life for the jacket
assembly, with full integrity
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PART 8 LABVISION SOFTWARE

NOTE

LabVision software is available on request from the factory
and is not shipped with the boiler/ water heater.

To operate LabVision software a Laptop and LPT1/USB
connection cable are needed.

8.1 STARTING UP LAB VISION

Locate the file named LabVision.exe, the appearance of the
icon is shown:
Figure 24: LabVision Icon

LabWision. exe
A startup screen will appear on screen:

Figure 25: LabVision Startup Screen

e " P -

When a connection between LabVision and the DynaMax
boiler is established the blue status bar on the bottom-right
will scroll from right-to-left and back again.
If a connection is not established between LabVision and the
DynaMax boiler, a proper connection will need to be
established before advancing to the next steps.

¢« Go to Options > Communication > Preferences

¢ A Preferences screen will pop up

« Under the Project Tab in the Protocol box select the

Argus Link connection

Figure 26: Selecting Argus Link Protocol

Preferences

Communication  Project ILogg\ng]

Project Lewvel |l O (low > Device List

[~ Communication setings:

Baudrate - 1200 Baud
AL active time : |50 % 100 ms

Protocal
" Echo protocal &+ Argus Link

- Temperature:

" Degrees (%C) % Fahrenhet (°F)

Cancel

e Click on the Communication Tab

e In the Communication Port pull down menu
select the address of Argus Link USB port.

e Click [OK]

e Use the pull down menu to jump to the desired
mode of operation.

Figure 27 : Selecting Communication Port

Preferences

Communication ] Project | Logaing

Communication port-

AV4L550P
COM1
i COM3

Bus address FastConnect address

13 |1 oo 0 = off
14

15 Settable device addr

100

Communication dil versior:
Jan 15 2007 15:07:39 [R5 232][Argus-ta-USE]

Ok | Cancel |

The three blue status bars located at the bottom-right of the
screen will move left-to-right and back again. This confirms
that a successful connection has been established between
LabVision and the DynaMax boiler.

USB connector address is shown in the bottom-left.

NOTE

Do not make any other parameter or setting changes other
than those stated in the manual as they will have a
detrimental effect to the DynaMax Boiler.

8.2 ADJUSTING FAN SPEEDS

Use the pull down menu to access DynaMax settings:
Figure 28: Pull Down Menu

V. Uniited BEX]

W | W3 3 [[F11 DM mode sloggrgAL [~ User - Default-0

P O mod AToana AL |
DH mock 4 AL

DHWAL

Comport chred Checksum it Logiie:

To adjust ignition fan speeds. Use the pull down menu or the
function keys on the keyboard, select Settings. This will bring
up the Settings screen.
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Parameters shown in blue text can be adjusted. To change a
blue coloured parameter, place the cursor on top a
parameter and double-click. This will bring up a window to
enter the desired values of operation.

Figure 29: Settings Screen

LabVision - Argus Vision B.Y. - 01 - Settings.xm{ WX
e Options Tooks Language Users telp
DEdsE W | D S| F-0-Setings - User : Default- 0
*Ble items can be changed ‘/3 A M[ ‘F Q
| APPLIANCE_TYPE : 1 ‘ 2 /AN USRS
—TTTTTTS
Boiler types
3way pump delay period : 10 sec 1 FR_MIN : 930 rpm.
= FRLIGNIT : 2095, rpm
on FR_MAX : 6210 tpm
SPARK FREQ : 25 He ‘ Max stack setpaint : 212 =
Fan offsets 2 FR_MIN : 90 rpm
= FRLIGNIT : 2094 rpm
OFFSET_FR_MIN : 0 P T o
OFFSET_FR_MAX : 0 rpm ek o o
h 5 FR_MIN : 950 rpm
Heat 3 2
= FRLIGNIT : 2085 tpm
DIf max wait tire : 30 s FR_MAX : 6120 rpm
Diffdelta T min. : 45 o Max stack setpoint : 212 o
= FR_MIN : 1620
Flow switch 4 ! i
FRLIGNIT : 2696 rpm
Flow swith Low water cutoff FR_MAX : 5280 rpm
e ————————— M stack setpoit : 212 F
CONTROL_CONFIG_BYTE : 0 ver cupots
FLOW_SWITCH_TIVE 115 sec 5 FR_MIN : 1620 o
FLOW_ SWITCH.TIVER ;0 sec FRLIGNIT : 26% o
LOW_WATER_NO_FLOW_FLAG : 0 FR_MAX : 5280 pm.
NO_FLOW_CNTR 0 Max stack setpoint : 212 o
) ava3TCaw Checksum st Logile: [

«  The Appliance name is listed under Appliance Type
«  Fan speeds are listed which corresponds to the
appliance address, listed below:

Table 17: Appliance Type Designations

Appliance DynaMax
Type Model

o

80
100
150
200
210
250
260
299
399
500
600
750

O©|0|N|O |0 | |[W|N |-

=y
o

=
=

NOTE

Only change the fan speed settings with the associated
boiler, as only this will have an effect on boiler performance.

8.3 LABVISION CENTRAL HEATING

Use the pull down menu and select Central Heating to adjust
parameters in Central Heating. Before any parameters can
be adjusted the blue status bar must track left-to-right and
back again. Refer to Section 8.1 to resolve connection
issues.

Figure 30: Central Heating Screen

LabVision - Argus Vision B.Y. - 04 - Cantral Heating xnl =]
Eile Options Tools Language Lsers Hep
Dedsa | WS 5| [F-04-ContialHeatig - User : Default- 0

* Bl itams can be changed.

T General
T_SURPLY : 76,2 o STATE : PRE_PURGE 1
T_RETURN : 76,3 o STATUS : cH
T_DHW_OUT : 140 F T
TRLUE 750 o £ .
> Noerror
T_OUTDOOR_MEAN : 22,0 o
L APPLIANCE TYPE : APT 120
CH Inputs Spark freq : 25 e
TR o Flamerod:0  ->00 uA
CHdemand : on
CH_ REQUEST :on JUVPERS : 00000001
RT_input : Closed! Max stack setpoint 1212 oF
T Stack diff. : 18 o
CH_MODE ; 0 Fan
CH_SETPOINT : 160 = in speed : 990 rpm Offset 10
CH_HYSTERESE 1 9 & Igniton speed : 2936 rpm
Max speed : 6210 rpm offset : 0
ANTL CYCLE PERIOD ; 20 sec
POST_PUMP_CH_PERIOD : 30 sec Target fan speed 1 3000 rpm
PIOP_CH 27 Actual fanspeed : 0 o
PID1CH: 15
e Post purge period : 10 sec
_PILNIN_SITH_OFFSAT : 590 x_PR_HAX VITH DFFSAT : 6210
e AVAITCEW Checksum st Logfile : test_001 csv (L]

Figure 31: Central Heating Temperature Screen

Temperatures
T_SUPPLY : 76,9 °F
T_RETURN : 75,3 oF
T_DHWW_0OUT : 14,0 oF
T_FLUE : 75,0 oF
T _OUTDOOR_MEAN @ -22,0 oF

Real-time temperatures are updated on screen, this
includes:
e OQutlet/Supply Temperature (T_SUPPLY)
¢ Inlet/Return Temperature (T_RETURN)
e  Stack/Flue Temperature (T_FLUE)
e Outside Temperature (T_OUTDOOR_MEAN)
e DHW Supply Temperature (T_DHW_OUT)

The CH demand switches between on/off depending on
whether or not there is a demand for central heating. The
other parameters are designed for internal control purposes.

Figure 32: Central Heating Input Screen

CH Inputs

RT_BUFFER : 00000000
CH demand : on

CH_REQUEST : an
RT_input : Closed
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Table 18: CH Input Screen Parameters

Parameter Parameter Description
Displays the state of the room
CH demand thermostat. When ‘on’ is shown the

thermostat is closed, when ‘off’ is
shown the thermostat is open.

Displays the response of the boiler.
‘on’ is displayed when the boiler is

responding to the CH_demand, and
CH_REQUEST ‘off’ is displayed when a CH_demand
does not exist.

8.3.1 Central Heating Mode, Installer Level

Figure 33: Central Heating Mode Settings
CH-Settings

CH_MODE : D
CH_SETROINT : 160 oF
CH_HYSTERESE : 9 oF
ANTI_CYCLE_PERICD : 20 ser
POST_PUMP_CH_PERIOD : 30 ser
FID_P_CH : 27
PID_I_CH : 15
FID_D_CH : 128

The following parameters can be adjusted:

Table 19: CH Mode = 0 Parameters

8.3.2  Central Heating Mode = 1, 2, 3 Installer Leve |
Figure 34: Central Heating Mode = 1, 2, 3 Settings

Settings for weather compensation

CH mode @ Mormal operation

CH setpoint @ 160 °F
tday ref : 86 ElE
Slope @ 1,0
CH Setpoint Min © 32 S5
CH Setpoint Max @ 230 (5=
T Might Reduction : 18 GIF
Weather comp. sefpoint @ 63 1=

Quick test weather flag : 0

Formula :

Ch_setpoint = t day ref + ({20 - T outside) * Slope)

The following parameters can be adjusted:

Table 20: CH Mode = 1 Parameters

Parameter Parameter Description

CH Mode 1, 2

To determine the outdoor reset
temperature. The control uses the
following algorithm to adjust the
CH_setpoint accordingly:
CH_Setpoint = t_day_ref + [(20-

T Outdoor) * Slope (Default: 68°F)

t day_ref

CH Mode 1, 2

To determine the outdoor reset
Slope temperature. See t_day_ref to
understand how Slope affects

heating system. (Default: 160°F)

CH Mode =0, 1, 2,3

To provide a modulation rate above
and below CH_setpoint. For example,
CH_Hysterese if the value is 10°F and the setpoint is
160°F, the boiler will begin to
modulate at 155°F and shut off at
165°F. (Default: 9°F)

CH_Setpoint. (Default: 1.0)
Parameter Parameter Description CH Mode 2
CHMode=0,1,2,3 If setting an alternate temperature
CH_Setpoint To provide a target setpoint for the for night time usage is desired.

T_night_reduction This parameter is only engaged

when the external clock is satisfied.
(Default: 50°F)

To change a blue coloured parameter, place the cursor on
top of a parameter and double-click. This will bring up a
window to enter the desired values. Take note of the
minimum and maximum values that can be entered, as the
values entered MUST be within this range.

The Anti_Cycle_Period is designed to prevent the boiler from
short-cycling. The preset time must be satisfied before the
boiler will start up. Post_Pump_CH_Period determines the
time the on-board pump continues to circulate after the
burner has shut off and completed its post-purge cycle.

CH Mode 2

When the outdoor temperature is
below the preset Weather_setpoint
Weather_setpoint | a CH demand is created.
Therefore, the CH demand is not
dependent on Room Temperature

input. (Default: 68°F)

To change a blue coloured parameter, place the cursor over
a parameter and double-click. This will bring up a window to
enter the desired values of operation. Take note of the
minimum and maximum values that can be entered, as the
values entered MUST be within this range.
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8.4 LABVISION DOMESTIC HOT WATER

Use the pull down menu and select DHW Mode 4 to adjust
parameters. Before the parameters can be adjusted the blue
status bar must track left-to-right and back again. Refer to
Section 8.1 to resolve connection issues.

Real-time temperatures are tracked by LabVision and are
displayed on the screen. The temperatures tracked are:

e OQutlet/Supply Temperature (T_SUPPLY)

¢ Inlet/Return Temperature (T_RETURN)

e DHW Supply Temperature (T_DHW_OUT)

Figure 35: DHW Temperature Screen

Temperatures

SUPPLY_TEMP : 77,0 °F
T_RETURM : 76,4 °F
T_DHW_OUT & 14,0 °F

The DHW section of the screen displays the request that the
DynaMax boiler is responding to. The values for the 4
parameters: Storage cold, Tap flow, DHW request, and Pre
heat vary from 0 (off) and 1 (on). This information is also
listed under the General section as well.

Figure 36: DHW Inputs

DHW inputs

Storage cold @ 0

Store warm hold : 0
DHW request : 0

Pre heat : O

The Pre heat and Tap flow screens are designed to keep the
DynaMax operating at its optimum setting, and therefore
these parameters will be preset and cannot be changed.

8.4.1 DHW Mode = 0, Installer Level

No parameter changes can be made in this mode as this
mode is used for a DynaMax Heating boiler.

8.4.2 DHW Mode =1, 2 Installer Level
Figure 37: DHW Mode = 1, 2 Settings

_DHW settings

DHWY_MODE : 0
Dhw_Setpaint @ 120 g
DHW hystereses up @ 9,0 i
DHW hystereses down @ 3,6 (Z[E
Post pump DHYY period : 15 SeC

DHWY store hystup @ 4 °F
DHwY store hyst down @ 4 °F
DHW store supply extra: 36 2=
DHW supp hystup @ 4 2

DHWY supp hyst down @ 4 i

DHWY store hold warrm: 4 °F
PID_F_DH 2 10
PID_I_DHW @ 25
FID_D_DHW : 0

The following parameters can be adjusted:
Table 21: DHW Mode = 1, 2 Parameters

Parameter Parameter Description

To provide a target setpoint for the

Dhw_Setpoint storage tank. (Default: 135°F)

To detect the start of a storage
DHW store hystup | 11 demand. (Default: 4°F)

DHW store hyst To detect the end of a storage tank
down demand(Default: 4°F)

Additional increase in the setpoint
temperature above Dhw_Setpoint
(Default: 36°F)

DHW store supply
extra

To provide a modulation rate

DHW supp hyst up above Dhw_setpoint(Default: 4°F)

Supply temperature below
Dhw_Setpoint to start ignition
sequence. (Default: 4°F)

DHW supp hyst
down

When the storage tank
temperature drops below this value
DHW store hold the boiler will fire at minimum fire.

warm This functionality is only activated
when the boiler is in Standby
mode. (Default: 120°F)

To change a blue coloured parameter, place the cursor over
a parameter and double-click. This will bring up a window to
enter the desired values of operation. Take note of the
minimum and maximum values that can be entered, as the
values entered MUST be within this range

8.4.3 DHW Mode = 4, Installer Level

This mode can ONLY be accessed on a DynaMax
Combination model using a plate type heat exchanger. Use
the pull down menu and select DHW Mode 4 to adjust
parameters. Before parameters can be adjusted the blue
status bar must track left-to-right and back again. Refer to
Section 8.1 to resolve connection issues.

Figure 38: DHW Mode = 4 Screen

¥. - 09 - DHW-made 3&4.ml Lo&E

Heb

LabVision - Argus Visi

Fle Options Tooks Langu

DSds & W W[ Wl 3 3| [09-DHWmode 314 - User - Default- 0

General Te— S
STATE : PUVP_CH.0 APPLIANCE_TYPE : AFT 120 N/, J Ui
STATUS : CH .

ERROR_NUMBER : 255 inputs

ey Storage cold ; 0 Pre heat : 0

WARNING_NUVEER : 255 Tap flow 10 T4P flow - switch : 0

_ y DHW request : 0

Flarme curres ntiood | o

rm SUPPLY_TEMP ; 77,0 "

rem offset ;0 TRETURN : 76,4 "

Ignitor speed 2996 rpm offset : 0 T_OHW_OUT : 14,0 5
Maxspeed 16210 P Maxstack sepont :212 °F | Tap flow - Settings

Post purge period : 10 s Fledf, ;18 o

TAP_DETECT UNDELAYED : Na
Purmp : CH TAP_DETECT HYST DOWN 118 °F
_DHW settings TAP_FLOW_MASK_TIVE :0,0  sec (0 =DISABLE)
TAP_FLOW_MASK_TIVER : 0,0
TP_DETECT DHW_DROP 118 °F
TOHWdehta 00 oF

DHW_MODE : 0
Pre_Heat_Setpoint_ECO : 113

TAP_FLOW_HOLD_ACTIVE_TIME : 15,0 sec

%_TAP_FLOW_HOLD_ACTIVE_TIVER 0,0 s
TAP_DETECT_STOP_DIFF_SUPPLY_RETURN : 36  °F ->Enabled (-1 = DISABLE)
PID_P_DHW ; 10 TAP_DETECT_STOP_DIFF_RETURN_DHW : 9 F ->Enabled (-1 = DISABLE)
PID_LDHW : 25 ADDED_HYST_UP_TIME : 30 s
FID_D_DHW ;0 ADDED_HYST_UP 10
X_ADDED_HYST_UP_TIVER : 0

OHW hystereses down : 36
Post purmp DHW period : 15

IR R

X PIWM_VALUE : 1

= AasTCRW Checksum st Logfle : R 75iantest_002.csv LT
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Table 22: DHW Mode = 4 Parameters

Table 23: Status Readouts

To provide modulation rate above

DHW hystereses up | n setpoint. (Default: 9°F)

DHW hystereses To provide modulation rate below
down DHW setpoint. (Default: 4°F)

When the plate heat exchanger
outlet/supply temperature drops
below this value the boiler will fire
at minimum fire. This functionality
is only activated when the boiler is
in Standby mode. (Default: 110°F)

Pre Heat Setpoint

To provide modulation rate above
Pre-heat setpoint for the plate heat
exchanger during pre-heat.
(Default: 0°F)

Pre Heat hyst_up

To detect the start of the pre-heat
sequence below Pre Heat Setpoint.
(Default: 9°F)

Pre Heat
hyst_down

Figure 39: DHW Mode = 4 Pre heat and Tap flow Scr een

& Labvision - Argus Viston B.V. - 07 - Pro-heatoant BEx
e Qptions Jools Language Users Help
JEdsd W WD 3|7 07 Prehea

- ser : Def
= P
* b ftems can b changed (@ //\\ m\
\Lﬁ V]
S —CITTNE

Pre heat

PRE_HEAT_AFTER_TAP_TIVE : 120 (0 =DIstele)

X_PRE_HEAT_AFTER_TAP_TIMER : 0

PRE_HEAT_HYST_UP : 0 ~> Above set paint

s
s
Freheatsetpaint: 114 oF
o
PRE_HEAT_HYST_DOWN : 9 o
X_PRE_HEAT DELAY_TIMER : 0,0 sec (0= DISABLE)
FRE_HEAT_DELAY_TIVE : 100 sec
FRE_HEAT_FLAG :0

PRE_HEAT_HOLD_TIVE : 0,0 sec (0= DISABLE)

X_PRE_HEAT_HOLD_TIMER : 0,0 ssc

o) AVAITCSW Checksum st Loglle. (L}

The General screen provides access to the state of the
boiler at any point in time. The State displays the operation
of the DynaMax boiler. This parameter ranges from
STANDBY, PRE_PURGE, SAFETY_ON, SAFETY_OFF,
IGNIT_O, IGNIT_1, and BURN. The complete breakdown of
the ignition sequence is listed in Table 43. Status displays
that the boiler is in CH, PRE_HEAT or TAP mode.

Parameter Parameter Description Parameter Parameter Description
; ; Keeps the plate heat exchanger
. To provide a target setpoint for -~ ;
DHW_Setpoint DHW. (Default: 120°F) warm. This is accorr'lplllshed py
firing the boiler at minimum fire.
PRE HEAT This process repeats itself with a 2

minute gap in between firing if the
plate has not reached Pre Heat
Setpoint.

When there is a domestic demand
TAP and the burner will fire until
DHW_Setpoint is satisfied.

DHW Priority

When both a CH demand and DHW demand exist
simultaneously, DHW will always have priority. When DHW
demand ends the boiler will check the Outlet Temperature
sensor or System Sensor and Room Thermostat switch to
determine if CH demand exists.

Flame rod current in HA can be observed. Fan speeds
cannot be altered here, instead they are varied under the
Settings screen. This is covered in Section 8.2 of this
manual The Maximum Stack Setpoint Temperature and the
Flue Diff. Temperature cannot be changed to preserve
reliable and efficient performance.

Figure 40: DHW Mode = 4 General Screen

General

STATE : PUMF_CH_O
STATUS @ CH
ERROR_MUMBER : 235
== MNoerrar
WARMING_MUMBER 1+ 235
== Mo warning
Flarme rod 1 0
Target fan speed : 4200 rpm
Actual fanspesd 4530 rgm

APPLIAMCE_TYFE @ APT 120

Flame current : 0,02

Min speed @ 990 rpm Offset : 0
Ignition speed : 2996 rpm Offset 1 0
FMax speed @ 6210 rpm Max stack setpoint : 212 °F
Fost purge period : 10 sec Flue diff, : 18 oF
Pump : CH

To change a blue coloured parameter, place the cursor over
a parameter and double-click. This will bring up a window to
enter the desired values of operation. Take note of the
minimum and maximum values that can be entered, as the
values entered MUST be within this range

Figure 41: DHW Mode = 4 Settings

DHV/ seftings
Tank =et point : 149 F
Dhar Setpoint @ 142 °F
DHII hystereses up @ 3.8 i
DHW hystereses down : 3,6 L
Post pump DHWN period @ 15° sec

PID PDHI : 10
PIL T DHU : 40
PID D DHW : 128
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8.5 LABVISION CASCADE

When connected in a cascade setup the Master boiler can
control up to 7 slave boilers (ie. a total of 8 boilers) from the
control panel of the Master Boiler. All diagnostic, control
operation can be performed on the Master boiler, which can
then relay the relevant information to the slave boilers.
Therefore a direct connection to the Master Boiler and
LabVision is required for communication using LabVision.

When the master boiler detects a heat demand for CH this
boiler will start and uses it own parameters for CH demand.
If after cascade_delay_time the system temperature is still
below the setpoint the next boiler will start.

When the master temperature (T_system) plus
cascade_hyst is greater than the setpoint a boiler will be
stopped. If after a period of cascade_delay_time this
situation is still present the next boiler is switched off.

In a situation where there is an installation of more than 8
DynaMax boilers in the Cascade system, a Zone Master can
be ordered with the system. This Zone Master functions in
the same way as the DynaMax Controller controlling the
Cascade function and can support up to 64 DynaMax
boilers.

Refer to section 12.14 Cascade Setup to install a Cascade
system setup.

Figure 42: Cascade Screen

Display 1 (Cascade master) Display 2
AL Master 1 0 BL Master 0
MK_T_SUPPLY : 0 oF
MM_CH_SETPOINT: 0 °F
CASCADE_HYST:0  °F
CASCADE DEMAND :0  sec
CASCADE_TIME : 2550  sec
CASCADE_TIMER : O
CASCADE_SLAYES : 00000000
MN_CASCADE_STATE : 00000000
Mainboard 1 Mainboard 2
DHW_MODE : 00 DHw_MODE : 14
AL Slave : 0 AL Slave : 0
x_CASCADE_STATE : 00000000 *_CASCADE_STATE : 00000000
RT_FLAG : O RT_FLAG : O
CONTROL_COMFIG_BYTE : 14
] |
| |
T_SUPPLY_1_HI : 14 <F T_SURPLY 1 _HI: 14 °F
T_RETURK_HI : 14 “F T_RETURM_HI: 14 °F
ERROR_MUMBER. : 00 ERRCR_MUMEER : DO
Target fan speed : 0 Target fan speed @ 0
FR_MAY 1 0 FR_MAY : 0
FR_MIN {0 FR_MIN: 0
P_CH_Maz: 0 P_CH_Maz: 0
FR_IGNIT : 0 FR_IGNIT : 0
FR_IGNIT : O FR IGNIT: O

The following parameters can be adjusted:

Table 24: Cascade Parameters

Parameter

Parameter Description

CASCADE_HYST

This parameter is entered to
provide a modulation rate above
and below the setpoint. This value
must be smaller than the
CH_Hysterese.(Default: 9°F)

CASCADE_DELAY_TIME

This parameter is entered to
implement a delay time between
the startup of one boiler to the
next. This timer starts when a
flame signal is detected from the
first boiler.(Default: 120 sec)

8.6 DATA LOGGING

LabVision software also comes equipped with data logging
capability which has the ability to track return/supply, DHW
temperatures, actual and target fan speed, state and status
in a graph as the boiler is operating. This is a beneficial
feature as it improves the ability to troubleshoot and

diagnose issues in the

field.

Figure 43: Data Logging Screen
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To select the parameters that need to be viewed or
recorded, a Parameter Selection Box on the bottom left-side
of the screen contains all the parameters that LabVision can
track. To view or record the parameter that is required, click
the check box beside each parameter. When finished
selecting the parameters required, click on Update and this
will refresh the logging screen.

Figure 44: Parameter Selection Box

v 100-5TAT
b 100- 5TAT

B
15

[ 100 - T ap How :

|Ipdate

o |

|

To adjust the viewing area, this can be done by adjusting the
margins for the left y-axis, right y-axis and the timeframe with

which to view.
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Figure 45: Adjust Viewing Area

- awiz left ‘' - auiz right - axis

Iir i EV Iir =V ' Limit?

[0 2l feme 2 | [ & e 3 [03] [seconds) -]

To record the data that is shown on screen, go to the
Toolbar and click on Logging > Start Logging. A window will
pop up on screen asking for a file name for the log file to be
captured. DO NOT change the file type, as LabVision must
record the log file as .Csv. As soon as file name is confirmed
by clicking on ‘Open’, LabVision begins capturing the data
immediately.

Also notice that the status bar has changed from blue to red.
This demonstrates that LabVision is recording to the log file
specified. The amount of data collected can be limited to a
certain size inside LabVision. When a maximum memory
limit is set, this results in over-writing previously written data
in the same log. Therefore it captures the most recent
amount of data. To prevent this from occurring this feature
can be turned off by clicking on Options > Options > Logging
tab and uncheck the parameter ‘Limit Logfile’. With this
feature disabled the log file will be dependent on time as
opposed to memory size.

Figure 46: Unlimited Log File Size

-

Preferences @

Communication | Project LDQQian

Logging

LogFile :

| Browse

I~ Limit Lagfile {10 ;:{ kb | [ Time logging?

P T T
Hurnbier of logfiles : 11 = !—1 | jHours) 'I

[~ Stop logging when limit reached

« |

When logging is complete click on Logging > Stop Logging.
Notice that the status bar has changed from red to blue. This
informs that Logging is complete.

To view a log file, Camus recommends using Microsoft®
Excel.

8.6.1 Procedure for Viewing Log Files in Microsoft®
Excel

1) Open Microsoft® Excel

2) Use a new spreadsheet, if Microsoft® Excel fails to
load a new spreadsheet. Click on File > New..

3) Data > Import External Data > Import Data..

4) A window appears titled ‘Select Data Source’

5) Identify the log file that was created and double-
click it

6) A new window will pop up titled ‘Text Import
Wizard'. Select Delimited. Click Next.

7) Place a checkmark beside ‘Tab’ and ‘Semi-Colon’
from the checkboxes provided. Click Next.

8) In the ‘Column data format’ section of the window,
ensure that ‘General’ is selected. Click Finish.

9) An ‘Import Data’ window will appear and check to
see that ‘Existing Worksheet’ is selected and the
text box reads: ‘=Sheet1!$A$1’ or ‘=$A$1". This
allows the data to start to importing the data at cell
‘Al’ of the spreadsheet.

10) Click OK.

11) The log file will appear on the spreadsheet.

8.6.2  Analysis of Microsoft ® Excel Log File

The log file parameters are divided into columns with a
reference to the time of data collection on each row. The
Status and State parameters are identified by numbers and
these can be translated into a description, listed below.

Table 25: Description of State and Status Parameter s

State Status
# Description # Description
0 | RESET 0 0 | STANDBY
1 | RESET 1 10 | ALARM
2 | STANDBY 0 14 | BLOCK
3 | SAFETY ON 15 | FROST PROTECT
4 | SAFETY_OFF 16 | CH
5 | PRE PURGE 17 | RESET STATE
6 | PRE PURGE 1 18 | STORAGE
7 [ IGNIT O 19 | TAP
8 | IGNIT 1 20 | PRE HEAT
9 [ BURN 0O
10 | POST PURGE 0
11 | POST PURGE 1
12 | PUMP CH 0O
13 | PUMP_CH_1
14 | PUMP_HW 0
15 | PUMP HW 1
16 | ALARM 1
17 | ERROR CHECK
18 | BURNER_BOOT
19 | CLEAR_E2PROM ERROR
20 | STORE BLOCK ERROR
21 | WAIT_A SECOND
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8.7 Error History

LabVision has the ability to record past blocking (E) and
lockout (A) errors. To access this feature use the pull down
menu and select History.

Figure 47: Error History

guege Users telp
FI A T -

The blocking and lockout errors are separated into their own
respective rows and are identified by their respective error
codes. This assists with diagnostic and service work as the
behaviour of the boiler can be tracked.

This screen also provides information of the number of
Successful Ignitions, Failed Ignitions and Flame failures due
to a lost flame signal.

Figure 48: History and Diagnostic Information

Due to a large number of error codes that can be presented,
LabVision comes complete with a feature in which to provide
a description of each error code. Double click on the phrase
‘Enter error number here for description’ and a window will
appear allowing the installer to identify the error.

Figure 49: Error Query
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PART 9 DYNAMAX CONTROL
PANEL

MENU <  Pressto enter Main
Menu. This provides
. access to System
Monitor, Settings,
Programs and Errors

CAMUS HYDRONICS
Dy naltax
System Manager
Version [xxxx]

DOWN RESET

¢ Pressto change

boiler parameter e Presstoreseta
values (Setpoint lockout error. This
Temperature, Date shown on the X

& Time) display as A##

*Where # denotes a
digit from 0 — 9.

o Press to ENTER to
. confirm selection or
to confirm a
parameter change

PC LPT1
Connection Port

PREVIOUS

e Pressto change
boiler parameter
values (Setpoint
Temperature, Date
& Time)
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9.1 INTRODUCTION TO THE DYNAMAX
CONTROL PANEL

For times when a notebook computer is not available, a
service technician will still be able to perform all the
functions described in LabVision, except for the logging
aspect.

The menu structure for the DynaMax Control Panel was
designed to be intuitive and easy to use for a first time user.
To maintain the DynaMax boiler at its correct settings three
levels of security is provided. User, Installer and Factory
with an increasing amount of parameters that can be
adjusted with each higher level of access. This is done to
provide an easy means of communication for the end user
and a more indepth approach for factory and installers
when installing and troubleshooting.

Figure 50: DynaMax Control Panel Layout

Figure 51: DynaMax Home Screen

CAMUS HYDRONICS
DYNAMAX
BOILER CONTROL
Version [xxxx Hxxx]

The display panel then defaults to the next screen which
provides System, Boiler and Hot Water temperature. For a
DynaMax heater that does not have domestic hot water
capability the status will display OFF.

A temperature readout of supply temperatures from the boiler
will be displayed. If the DynaMax is a water heater or a
combination unit it will also display the Hot Water
temperature.

Figure 52: Temperature and Status

System: ON
Boiler: “E ON
Hot Water: “F OFF
22 JUN 2007 16:38

Table 27: Temperature and Status Display Readout

DISPLAY
READOUT DESCRIPTION
ON Heat Request
OFF No Heat Request
Table 26: DynaMax Control Panel Key Functions System DHW DHW Request
KEY KEY DESCRIPTION ERR Lockout/ Blocking Error
MENU The MENU display is shown when pressed. NC No Communication
RESET | Only used during a lockout error situation ' ON Burner On, Responding to
ENTER Confirms selection of a parameter or Boiler CH Demand
parameter value OFF Burner Off
PREVIOUS Scroll backward through the parameter ON Burner On, Responding to
structure Hot Water DHW Demand
NEXT Scroll forward through the parameter structure OFF Burner Off
upP Increase a parameter value
DOWN Decrease a parameter value 9.2 MENU SCREEN

Levels of Access
Three access levels to simplify the use of the boiler.

User — Access to general boiler and display settings and
will allow adjustments to the central heating and domestic
hot water setpoint.

Installer —Access to all user parameters and allows for
changes to additional boiler parameters to allow for ease of
startup and serviceability.

Camus — Full access to DynaMax parameters and is only
open to Camus personnel.

Startup Display

Upon startup of the DynaMax boiler the DynaMax Control
Panel startup display is shown. This display is shown for 5
seconds upon startup. The Version # relates to the version
of software uploaded onto the boiler control.

Figure 53: Menu Display

MENU

2>System Monitor A
Appliance Settings
Display Options ]
Errors

From TEMPERATURE AND STATUS display;
1) Press [MENU] button.

System Monitor
Monitor Central Heating and DHW settings, if equipped.
System Monitor will be open to all levels of access.

Display Options
Changes to Languages, Date and Time, and Units of

measurement. The default setting is English, Fahrenheit and
Imperial. ‘Display Options’ will be open to all levels of access.
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Appliance Settings

Changes bhoiler characteristics. The User level will have
access to the first screen inside Appliance Settings which
allows for changes in Central Heating setpoint. A 4-digit
personal identification number (PIN) needs to be entered
before moving further into the controller. If an incorrect
PIN# is entered this will result in an error displayed on
screen.

Errors
Displays the lockout or error code along with a description
of the error.

9.3 SYSTEM MONITOR DISPLAY

Table 29: Central Heating Readout

DISPLAY
READOUT DESCRIPTION
outd Othoor Temperature (if
equipped)
In Return/Inlet Temperature to
CENTRAL Boiler
HEATING out Supply/Outlet Temperature to
Boiler
Setp Central Heating Setpoint
Flue Flue Temperature

Figure 54: System Monitor

SYSTEM MONITOR A

Active program:
Boiler Type

Pump : ON Standbyv

Domestic Hot Water Display
Figure 56: Domestic Hot Water

From MENU display;

1) Use [NEXT] to select ‘System Monitor’

2) Press [ENTER]

Table 28: System Monitor Display Readout

DOMESTIC HOT WATER 4
Temp (°F) D HW
In : Out
Setp: Flue: L

From CENTRAL HEATING display;
3) Use [NEXT] to view DOMESTIC HOT WATER

When no action is detected for 30 seconds, the screen will
default back to the Temperature and Status Display.

Central Heating Display
Figure 55: Central Heating

CENTRAL HEATI NG A
Temp (°F}) COutd:

In : Out

Setp: Flue: v

From SYSTEM MONITOR display;

display.
DISPLAY Table 30: Domestic Hot Water Readout
READOUT DESCRIPTION
Boiler is designated as a DISPLAY DESCRIPTION
Active MASTER | Master boiler in the cascade READOUT
Program setup DHW DHW Temperature
SLAVE EO,'IIer IS tdhe5|gnateéi as "’t‘ Slave In Return/Inlet Temperature to
oiler in the cascade se ;
LN TE tb DOMESTIC Boiler
PUMP ON Pump is active HOT out Supply/Outlet Temperature to
OFF Pump is inactive (idle) WATER Boiler
Heating and DHW Request (if Setp Central Heating Setpoint
Standby equipped) is satisfied
STATUS q. pp_ — Flue Flue Temperature
Boiler is firing at the rate
#H% ot _
indicated System Display

Figure 57: System

SYSTEM A
Temp (°F) Sys

In : Out

Setp: Flue: L

From DOMESTIC HOT WATER display;
1) Use [NEXT] to view SYSTEM display
Table 31: System Display Readout

2) Use [NEXT] to view CENTRAL HEATING display.

DISPLAY
READOUT DESCRIPTION
S System Temperature of
yS .
Primary Loop
In Return/Inlet Temperature to
Boiler
SYSTEM Supply/Outlet Temperature to
Out !
Boiler
Setp Central Heating Setpoint
Flue Flue Temperature
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Run Time Display
Figure 58: Run Time

RUN TIME A

Total Run Time

since Installation:
Ohrs.¥

From SYSTEM display;
1) Use [NEXT] to view RUN TIME display
Table 32: Run Time Display Readout

DISPLAY
READOUT DESCRIPTION
Monitors the amount of
operational time since the
Total Run DynaMax was installed. The
RUN - ) - !
Time Since | timer starts counting as soon
TIME - . . .
Installation | as it receives a flame signal to
the time the flame signal
disappears

Fan Diagnostics Display

Figure 59: Fan Diagnostics

FAN DIAGNOSTICS{RPM)
Min. 1500 lgn.

Max. Actual

From RUN TIME display;
1) Use [NEXT] to view FAN DIAGNOSTIC display.
Table 33: Fan Diagnostic Display Readout

DISPLAY
READOUT DESCRIPTION
Min Programmed Minimum
) Fan Speed
FAN Max. E;c;]géarggjed Maximum
DIAGNOSTICS 2 _
(RPM) Ign Programmed Ignition Fan
) Speed
Actual Actual Fan Speed
updated in real-time

To move back to the previous screen at anytime, press the
[PREVIOUS] button.

Display Options Display

Figure 60: Display Options Display
DISPLAY SETTINGS
=Language
Date and Time
Units

From MENU display;

1) Use [PREVIOUSJ/[NEXT] button to select ‘Display
Options’.
2) Press ENTER

Language Display

Figure 61: Language Display
LANGUAGE
=SEnglish
Francais
Espaiiol

1) Use [UP)/[DOWN] buttons to select preferred
language.
2) Press [ENTER] to confirm.

Date and Time Display
Figure 62: Date and Time Display

DATE AND TIME
SWednesday

22 JUN 2007
15:17

From LANGUAGE display;

1) Use [NEXT] to view DATE AND TIME display

2) Use [UP)/[DOWN] and the cursor arrow will point to
either the Day, Date or Time

3) Press [ENTER] to change a parameter. The
parameter will begin to flash

4) Use [UP]/[DOWN] to change parameter value.

5) Press [ENTER] to confirm.

Units Display
Figure 63: Units Display
UNITS

S Imperial
Metric

From DATE AND TIME display;

1) Use [NEXT] to view UNITS display

2) Use [UPJ/[DOWN] to select the desired unit of
measurement

3) Press [ENTER] to confirm.

To move back to the previous screen at anytime, press the
[PREVIOUS] button. When no action is detected for 30
seconds, the screen will default back to the Temperature and
Status Display.
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9.4 CENTRAL HEATING DISPLAY

Figure 64: Programs Screen

APPLIANCE SETTINGS A

mCentral Heating
Domestic Hot Water
Cascade Control L J
Boiler Control

From MENU display;

1) Use [PREVIOUSJ/[NEXT] button to select ‘Central

Heating’
2) Press [ENTER]

Figure 65: Central Heating Setpoint
CENTRAL HEATING

Enter Desired Temp.:
(45..185) :
CH Setpoint 160°F

Figure 66: Installer Access
CENTRAL HEATING
PINZ
Additional

Enter To Access

Parameters: 0000

From CENTRAL HEATING display;

1) Use [NEXT] to enter INSTALLER ACCESS
display

2) Use [UP/DOWN] to enter desired PIN #.

3) Press [ENTER] to confirm.

The correct PIN # must be entered in order to gain access to

additional parameters.
Figure 67: Central Heating Mode Selection

CH PARAMETER
CH MODE # (0-3):

From INSTALLER ACCESS display;

description of each mode is available in 6.3 The
following parameters can be selected from the
installer level.

2) Press [ENTER] to confirm.

Ignition Fan Speed Display
Figure 68: Ignition Fan Speed

CH PARAMETER
lgnition

Fan Speed: &

¥
RP

From CH PARAMETER > Minimum Fan Speed display;
1) Use [NEXT] to enter Ignition Fan Speed setting.

1) Use [UP)/[DOWN] to select mode of operation. A full

2) Use [UP/DOWN] to select desired ignition fan speed

3) Press [ENTER] to confirm

The Ignition Fan Speed must be between the minimum fan

speed and maximum fan speed.

Central Heating Mode =0, 1, 2, 3 Installer Level P arameters

The following parameters can be scrolled through using the [NEXT] button. When no action is detected for 30 seconds the display

will revert back to the Temperature and Status display.

Table 34: Central Heating Parameters

MODE DISPLAY
SELECTION READOUT RE=CRIGIRN
CH_Setpoint To provide a target setpoint for the heating system. (Default: 160°F)
0,1,2,3 To provide modulation rate above and below CH_setpoint. For
CH_Hysterse example, if the value is 10°F and the setpoint is 160°F, the boiler will
begin to modulate at 155°F and shut off at 165°F. (Default: 9°F)
To determine the outdoor reset temperature. The control uses the
T day_ref following algorithm to adjust the CH_setpoint: CH_Setpoint = T_day_ref
CENTRAL 1,2 + [(20-T_Outdoor) * Slope]. (Default: 68°F)
HEATING Slope To determine the outdoor reset temperature. See T_day_ref to
understand how Slope affects CH Setpoint. (Default: 1.0)
T_nightreducton | 1L e oy ™ T T
2 When the outdoor temperature is below the preset Weather_setpoint a
Weather_setpoint | CFCemandis el Trereloe, the G demand f ot dependent on
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9.5 DOMESTIC HOT WATER DISPLAY
Figure 69: Program Selection

APPLIANCE SETTINGS 4
Central Heating

BDomestic Hot Water
Cascade Control ¥

Boiler Control

From MENU display;

Figure 72: Domestic Hot Water Mode

DHW PARAMETER
DHW MODE # (0-3):

From INSTALLER ACCESS display;

8) Use [UPJ/[DOWN] to select mode of operation. A full
description of each mode is available in 6.3. The
following parameters can be selected from the

1) Use [PREVIOUS]/[NEXT] to select ‘Domestic Hot installer level.

Water’
2) Press [ENTER]

Figure 70: Domestic Hot Water Setpoint
DOMESTIC HOT WATER
Enter Desired Temp.:
{(100..200) :

DHW Setpoint 120°F

3) Use [UP]/[DOWN] to select DHW Setpoint.
4) Press [ENTER]

Figure 71: Installer Access

DHW PARAMETER

Enter PINZ To Access
Additional

Parameters: 0000

From DOMESTIC HOT WATER display;

5) Use [NEXT] to enter INSTALLER ACCESS

display
6) Use [UP)/[DOWN] to enter desired PIN #.
7) Press [ENTER] to confirm

9) Press [ENTER] to confirm.

NOTE

DHW Mode = 0, is ONLY used when Central Heating is
selected. ‘DHW Functionality Disabled’ is shown on
screen.

Regardless of which DHW mode is selected. A number of
common screens will first be shown.

Ignition Fan Speed
Figure 73: Ignition Fan Speed

DHW PARAMETER

lgnition Fan Speed: &
v

RP

From DHW PARAMETER > Minimum Fan Speed;

1) Use [NEXT] to enter Ignition Fan Speed setting.

2) Use [UPJ/[DOWN] to select desired ignition fan
speed

3) Press [ENTER] to confirm

The Ignition Fan Speed must be between the minimum fan

The correct PIN # must be entered in order to gain access speed and maximum fan speed.

to additional parameters.

Domestic Hot Water Mode =0, 1, 2, 3, 4 Installer L

evel Parameters

The following parameters can be scrolled through using the [NEXT] button.

: Domestic Hot Water Parameters

Table 35
MODE DISPLAY
SELECTION READOUT

DESCRIPTION

DHW_Setpoint

To provide a target setpoint for the storage tank. (Mode 1,2 Default: 135°F,
Mode 3,4 Default:120°F)

1234 DHW_hyst_up To provide modulation rate above the DHW_setpoint. (Default: 9°F)
DHW_hyst_down | To provide modulation rate below the DHW _setpoint. (Default: 4°F)
DO'\l_/:g?.TIC During a DHW request, the user will not be subjected to a stream of cold water
WATER Pre-Heat Setpoint | when the tap is first turned on. This also creates a buffer zone for the boiler to

fire up and modulate. (Default: 110°F)

3,4
' Pre-Heat hyst_up

To provide modulation rate above Pre-heat setpoint for the plate heat
exchanger during pre-heat. (Default: 0°F)

Pre-Heat
hyst down

To provide modulation rate below Pre-heat setpoint for the plate heat
exchanger during pre-heat. (Default: 9°F)
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9.6 CASCADE CONTROL
From MENU display.

1)

2)

3)

4)

5)
6)

7

8)

Figure 74: Menu Display

MENU

System Monitor i
Appliance Settings ;
Display Options "
Errors

Use [PREVIOUS]/[NEXT] to select ‘Appliance
Settings’
Press [ENTER]

Figure 75: Selecting Cascade Control

APPLIANCE SETTINGS &

Central Heating
Domestic Hot Water
HCascade Control L J

Boiler Control

Use [PREVIOUS]/[NEXT] to select ‘Cascade
Control’
Press [ENTER]

Figure 76: Enter PIN#
BOILER CONTROL

Enter PINZ
Additional

To Access

Parameters:

Use [UP])/[DOWN] to enter the correct PIN#.
Press [ENTER].

Figure 77: Cascade Address Selection

CASCADE PARAMETER &
Address Selection:
SMASTER Boiler

SLAVE Boiler 0r

Use [UP])/[DOWN] to select the option of a
‘MASTER Boiler’ or ‘'SLAVE Boiler'.
Press [ENTER] to confirm.

If ‘'SLAVE Boiler’ is selected assign it an address

of ‘2’ if this is the boiler immediately after the

‘MASTER Boiler. Assign a number of ‘3’ if it is the

third boiler in the system. Continue this until all
boilers have been assigned an address. Use
[UP]/[DOWN] to select the correct address

10) Press [ENTER] to confirm.

11)
12)

13)

14)
15)

Figure 78: Cascade Delay Time

CASCADE PARAMETER &
Cascade Delay Time
{1..13)

2 minvy

Use [NEXT] to enter Cascade Delay Time.

Use [UP]J/[DOWN] to select delay time. (Default: 2

minutes)
Press [ENTER] to confirm.

Figure 79: Cascade Hysterese

CASCADE PARAMETER &
Cascade Hysterese

5°FY¥

Use [NEXT] to enter Cascade Hysterese.

Use [UP])/[DOWN] to select delay time. (Default:

5°F)

NOTE

Cascade Hysterese must be a smaller value than

CH_Hysterese in order for the cascade system to function.

NOTE

1)

For a standalone boiler the Address Location is ‘0.

In a Cascade Setup the Master boiler MUST have the

Address Location ‘1'. Slave boilers MUST have

Address Location greater than ‘1’, as that is reserved

for the Master boiler.

16)

Press [ENTER] to confirm.

9.6 BOILER CONTROL
From MENU display

1)

2)

3)

4)

Figure 80: Menu Display

MENU
System Monitor A
Appliance Settings
Display Options L
Errors

Use [PREVIOUS]J/[NEXT] to select ‘Appliance

Settings’
Press [ENTER]

Figure 81: Selecting Boiler Control

APPLIANCE SETTINGS &
Central

Heating
Domestic Hot Water
Cascade Control L

BBoiler Control

Use [PREVIOUS]/[NEXT] to select ‘Cascade
Control’
Press [ENTER]
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Figure 82: Enter PIN#

BOILER CONTROL

Enter PINZ To Access
Additional
Parameters:

5) Use [UP)/[IDOWN] to enter the correct PIN#.
6) Press [ENTER].

Figure 83: Boiler Control

BOILER CONTROL

System Test A
¥
0

The following parameters can be scrolled through using the
[NEXT] button.

Table 36: System Test Parameters

NOTE

A Lockout Code and Internal Number are generated in the
event of an error. The Internal Number is used by the
DynaMax Controller to identify an error.

DISPLAY
READOUT DESCRIPTION
0 System Test Off
L Low Power Operation
SYSTEM TEST . .
I Ignition Power Operation
Maximum Power
H -
Operation

9.7 ERROR SCREEN
From MENU display.

Figure 84: Menu Display

MENU

System Monitor |
Appliance Settings
Display Options k|
Errors

1) Use [PREVIOUS]/[NEXT] to select ‘Errors’
2) Press [ENTER].

Errors are divided into lockout (A ##) and blocking (E ##)
errors. A full description of lockout and blocking errors is
detailed in 5.4. If there is more than one error present the
display will alternate through the errors. When no errors are
present the display will display ‘None’.

Figure 85: Error Screen

ERRORS

SMaster : E
Boiler : E
Boiler : E L)

3) Use [NEXT] to enter error detail screen.

4) Toreset a Lockout error. Press and hold [RESET]
until the error description line reads ‘None’

The following screen can only be accessed when an error is
present. This screen provides more details about the error
that has occurred.

Figure 86: Detailed Error Screen

MASTER
lockout

codeint.nr
error description
Reset error

MASTER

Either MASTER or SLAVE # (# is the slave # assigned to the
boiler) is displayed during an error situation

lockout
This will display ‘Blocking’ or ‘Lockout’ depending on the error
code

This will display the error code in the form of A ## (Lockout
code, Table 5.4.1) or E ## (Blocking error, Table 5.4.2)

nr

This will display the internal error number that the DynaMax
Controller uses to identify the error. The Internal Number can
be used interchangeably for Lockout error codes and Blocking
error codes.

error description

The error description block shall display the error in text. The
description is identical to Table 15 and Table 16 under section
5.4.

Reset error

If a lockout error occurs (A ##) pressing RESET shall reset
the error. For example, this can occur if the burner has failed
to ignite after three consecutive trials.
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PART 10 TROUBLESHOOTING

Table 37: Troubleshooting Table

COMPONENT

FAILURE MODE

ANALYSIS

Incoming Power

» Two wires interchanged, E21

* No effect on safety
« Live and Neutral wires are interchanged.

Transformer
Tripped

* The 24Volts and 120 Volts
wired are interchanged

 Transformer immediately burns out, replace
transformer

 Fuse on DynaMax Controller blows, replace 3.15A
fuse located at F1 on DynaMax Controller.

Pump Fails to

» Wiring Issue

» Check that wires are correctly wired from the
DynaMax Controller to the pump delay relay.
» Check that 115V is delivered to pump coil.

* Faulty Pump on a wet rotor
pump

* Pump impeller may be stuck. Use a flat head
screwdriver on face of pump to turn impeller

Circulate manually
» Replace Pump
* Air in the piping system « Purge all air from the piping system
* Internal Fault on DynaMax * Replace DynaMax Controller
Controller
» System pressure exceeds relief | « Replace the standard relief valve with a higher rated
. valve setting valve up to the maximum pressure of the heat
Relief Valve
exchanger.
« Improperly sized expansion tank.
* Flow Proving Device/ LWCO « Verify LED’s on current sensing transformer during a
contacts are open heat demand (wall hung)
» Check flow switch paddle (floor mount)
« Verify for closed valves or obstructions in boiler
Flow Proving pipIng

Device/ LWCO

« Verify that all air has been purged from the system
« Verify that wiring is correct

* Blown Fuse

* Replace 3.15A Fuse located at F1 on DynaMax
Controller.

« DO NOT use alternates as it may damage the
DynaMax Controller
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SYMPTOM

FAILURE MODE

ANALYSIS

Flame Failure
(Pressing the
manual RESET
on the DynaMax
Control Panel will
be required to
restart the ignition

« The boiler has failed to ignite
the burner after 3 unsuccessful
attempts

« Verify that all air has been purged from gas line

* Inspect spark electrode and related wiring for
damage and connection errors

« Verify that the ignition fan speed is set to 3000 RPM
through fan diagnostics screen.

« Verify that boiler is properly grounded

« Verify incoming gas supply pressure and that it
coincides with Table 10.

« Verify that the vent/ air inlet piping (if equipped) are
correctly installed and obstructions are not present.

* Verify 120 VAC and 24 VAC is being supplied to the
gas valve transformer from the DynaMax Controller
during ignition. Check wiring from DynaMax
Controller, Gas Valve Transformer and Gas Valve
Relay. If a signal cannot be detected, the DynaMax
Controller needs to be replaced

« If 24 VAC is present, check the outlet of the valve to
ensure that gas is flowing. With a manometer
connected to the outlet pressure tap of the gas

sequance) valve a negative pressure should be present during
pre-purge. When the valve is energized a change in
pressure should occur, if no change is detected the
gas valve has failed to open or it is passing
insufficient amount of gas. If this is an initial startup
increase the low fire gas setting by ¥ turn
clockwise.
* Inspect flame sensor and associated wiring. Replace
if necessary
* Inspect the burner. Refer to Burner Maintenenace in
section 11.7
» Replace the DynaMax Controller
» The DynaMax boiler was « Verify that minimum fan speed is greater than 2500
running and flame signal RPM
suddenly disappeared. This * Verify that all air has been purged from gas line
condition occurred 3 times. * Inspect spark electrode and related wiring for
damage and connection errors.
« Verify that boiler is properly grounded
« Verify incoming gas supply pressure and that it
coincides with Table 10.
Flame « Verify that the gas line connections to the boiler are
Disappears adequate
During a Run « Verify that the vent/ air inlet piping (if equipped) are
Cycle correctly installed and obstructions are not present

(Pressing the
manual RESET
on the DynaMax
Control Panel will
be required to
restart the ignition
sequence)

* Verify 120 VAC is being supplied to the transformer
from the DynaMax Controller during ignition. If a
signal cannot be detected, the DynaMax Controller
needs to be replaced

* Verify that 120 VAC and 24 VAC is being supplied to
the gas valve during ignition. If a signal cannot be
detected, the transformer needs to be replaced

* Inspect flame sensor and associated wiring. Replace
if necessary

« Inspect the burner. Refer to Burner Maintenance in
section 11.7

» Replace the DynaMax Controller if necessary
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SYMPTOM

FAILURE MODE

ANALYSIS

Noisy Operation

* Supply Gas Issue

» Refer to Part 3 Gas Connection in this manual.

» Natural Gas Pressure should read between 3" w.c.
and 14" w.c.

» L.P. Gas Pressure should be at 11" w.c.

* Air/Gas Mixture Issue

 Refer to Gas Valve Adjustment Procedure in section
10.2 of this manual for the proper combustion
setting.

« Air Inlet and/or Vent
configuration

 Refer to Part 2 Air Inlet and Venting

« Dirty/ Damaged Burner

* Refer to Burner Maintenance in section 11.7 of this
manual for the burner removal and inspection
procedure. Clean or replace the burner, if required.

* Air in the piping system

* Purge all air from the piping system

* Incorrect Igniter Gap

* Check that spark gap is 3/16”

Auto Reset High
Limit Trips

 The supply/ outlet temperature
has exceeded the setpoint
temperature specified.

« Verify that the system is full of water and that all air
has been properly purged from the system.

« Verify that the boiler is piped properly. Refer to
Piping Diagrams in Section 13 of this manual.

« Verify that 120VAC is being supplied to the boiler
pump on a call for heat. If voltage cannot be
detected check wiring.

« Verify that the pump is circulating when 120VAC is
detected. If not, pump impeller may be stuck. Use a
flat head screwdriver on face of pump to turn
impeller manually

« If 120VAC is present during a call for heat, but the
pump still does not circulate, replace the pump.

» Replace the main DynaMax Controller if necessary

Manual Reset
High Limit Trips
(Pressing the
manual RESET
on the DynaMax
Control Panel will
be required to
restart the ignition
sequence)

» AO3 appears on boiler display.

* Manual Reset Safety High Lmit
tripped, supply/outlet
temperature in excess of
210°F

« Verify that the capillary tube is broken. If this is the
case, replace Manual Reset High Limit

« Verify that the system is full of water and that all air
has been properly purged from the system.

« Verify that the boiler is piped properly. Refer to
Piping Diagrams in Section 13 of this manual.

« Verify that 120 VAC is being supplied to the boiler
pump on a call for heat. If voltage cannot be
detected check wiring.

« Verify that the pump is circulating when 120 VAC is
supplied. If so, pump impeller may be stuck. Use a
flat head screwdriver on face of pump to turn
impeller manually.

« If 120 VAC is present during a call for heat, but the
pump still does not circulate, replace pump.

Fan Speed Too
Low

* Actual fan RPM is 30% slower
than target fan speed.

« Verify wiring connections at the fan and DynaMax
Controller.

* Replace the fan

» Replace the DynaMax Controller.

Fan Speed Too
High

» Actual fan RPM is 30% faster
than what is required.

* Vent/ Air Inlet Lengths exceed the maximum allowed
equivalent lengths. Refer to Air Inlet and Venting
Section in Part 2 of this manual.

« Verify that there are no obstructions in the vent/ air
inlet pipes or at terminations

« Verify wiring connections at the fan and DynaMax
Controller.

* Replace the fan

» Replace the DynaMax Controller.
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SYMPTOM

FAILURE MODE

ANALYSIS

Temperature
Overshoot

« Stack temperature has
exceeded the limit set on the
boiler.

* Measure the resistance of the flue sensor at room
temperature, it should be approximately 10kQ.

 The supply/outlet temperature
has exceeded the setpoint
temperature specified.

« Verify that the system is full of water and that all air
has been properly purged from the system

« Verify that the boiler is piped properly. Refer to
Piping Diagrams in Section 13 of this manual

« Verify that 120 VAC is being supplied to the boiler
pump on a call for heat. If voltage cannot be detected
check wiring

« Verify that the pump is circulating when 120 VAC is
supplied. If so, pump impeller may be stuck. Use a
flat head screwdriver on face of pump to turn impeller
manually

« If 120 VAC is present during a call for heat, but the
pump still does not circulate, replace the pump.

» Replace the DynaMax Controller, if necessary.

Sensor Not
Connected

» EO1 shown on display. Supply/
Outlet sensor

» EO2 shown on display. Return/
Inlet sensor

» E03 shown on display. Flue
sensor

» E04 shown on display. DHW-
Out sensor

« Verify that the sensors are connected

« Verify that they are wired correctly.

» Measure the resistance of the sensors, 10kQ
Sensors.

* Replace the sensor if necessary

Sensor Shorted

* E11 shown on display. Supply/
Outlet sensor

» E12 shown on display.
Return/Inlet sensor

» E13 shown on display. Flue
sensor

» E14 shown on display. DHW-
out sensor

« Verify that the sensors are connected

« Verify that they are wired correctly.

» Measure the resistance of the sensors, 10kQ
Sensors.

 Replace the sensor if necessary

Fan Not Turning

» A33 shown on display. Fan
refuses to rotate

» Check fan power wires
« Fan signal wires are interchanged
» Minimum fan speed must be greater than 1500 RPM

Reset Button
Error

* ES1

* Reset button pressed more than 7 times in one
minute

Air Switch

* Blocked flue error

« Air Switch wire(s) is/are loose
« Air Switch is set too tight, reduce sensitivity by
turning screw ¥4 turn counter-clockwise.

Flame Detection
is out of Sync

 Flame detection is present
when no visible signs of a
flame exist

« Verify supply voltage for proper polarity.

» Check external wiring for voltage feedback

» Check internal wiring for proper connections

» Check the flame sensor and verify that it is clean
» Replace DynaMax Controller

Blank Display
Screen

* Blank display screen

* Replace fuse with factory 3.15A fuse.
« DO NOT use alternates as it may damage the
DynaMax Controller
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10.1  SETTING THE CORRECT COMBUSTION

1) Switch the main power off to the boiler by placing the
toggle switch in the ‘OFF’ position

2) Switch the main power on to the boiler and adjust
setpoint so that boiler begins ignition sequence.

3) Observe the boiler as it goes through its startup cycle
and operates at high fire. This cycle is detailed on Table
41 in section 12.14 Ignition Cycle.

4) Insert the combustion measurement probe into the stack
when high fire operation is observed. Check to see that
fan is running at maximum fan speed using the Control
Panel.

5) The combustion values should reside in the range listed
in Table 38. If combustion values are not within this
range refer to Section 10.2 Gas Valve Adjustment
Procedure to correct this issue.

Table 38: Combustion Values for High Fire

Natural Gas Propane
CO, [ofe) CO, CO
Max. | g 505 . 9.00% | <100 |  9.5%- <100
Fire PPM 10.0% PPM
i <100
Min. | 2 506 - 8.0% 9.0%-9.5% | <100
Fire PPM PPM

7) When the combustion values are satisfied record these
values as Camus requires these for warranty purposes.

8) Remove the combustion measurement device and
switch the main power off to the boiler by placing the
toggle switch in the ‘OFF’ position.

9) Replace the flue temperature sensor back to its proper
location.

10.2 GAS VALVE ADJUSTMENT PROCEDURE

If adjustment of the gas valve is required use the following
procedure.

In order to perform adjustments to the gas valve the
DynaMax must be firing before proceeding.

DM 080 — 150
Figure 87: Venturi & Gas Valve Assembly

LOW FIRE

ADJUSTMENT SCREW e \
A ) \
INPUT ADJUSTMENT =
SCREW

VENTURI

To adjust the high-fire setting

Use the DynaMax Control Panel

Press the [MENU] button > select Appliance Settings and
press [ENTER] > select Boiler Control and press [ENTER] >
Enter the correct Installer passcode.

Select ‘H’ for high power. The DynaMax should respond
immediately and fire at maximum fan speed.

Locate the input adjustment screw on the side of the venturi.
Using a flat head screwdriver turn the screw clockwise to
decrease CO; levels and counter-clockwise to increase CO;
levels. Turn the screw 1/4 turn in either way for each
adjustment to keep track of the adjustments. After adjusting
the screw wait a moment for the combustion levels to
stabilize before attempting to make any further adjustments.
Continue this procedure until combustion levels are satisfied.

On the DynaMax Control Panel select ‘O’ to return to normal
operation.

To adjust the low fire setting

Use the DynaMax Control Panel

Press the [MENU] button > select Appliance Settings and
press [ENTER] > select Boiler Control and press [ENTER] >
Enter the correct Installer passcode.

Select ‘L’ for low power.

The DynaMax should respond immediately and fire at
minimum fan speed. When this is achieved locate the low
fire adjustment screw as illustrated in Figure 86. This screw
is covered with a cap, which can be removed using a Torx
40 screwdriver. With the screw cap removed using a Torx 40
screwdriver rotate clockwise to increase CO, levels and
counter-clockwise to decrease CO; levels. When the correct
combustion values are achieved replace the screw cap back
on to the gas valve.

On the DynaMax Control Panel select ‘0’ to return to normal
operation.
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DM 200 - 399

Figure 88: DM 200 — 399 Gas Valve

LOW-FIRE AIRIGAS
L vl

RATIO ADJUSTMENT
(USE T-40 FOR ADJUSTMENT,
. QJ I‘:“‘I"TI
[ o _::"." p:
To adjust the high-fire setting

CLOCKWISE INCREASES CO03)

S~ GAS VALVE

HIGH-FIRE AIRIGAS

RATIO ADJUSTMENT

(USE FLAT HEAD SCREWDRIVER
FOR ADJUSTMENT,

CLOCKWISE INCREASES COy)

©

¥

Use the DynaMax Control Panel

Press the [MENU] button > select Appliance Settings and
press [ENTER] > select Boiler Control and press [ENTER] >
Enter the correct Installer passcode.

Select ‘H’ for high power. The DynaMax should respond
immediately and fire at maximum fan speed.

Locate the high-fire adjustment screw on the top side of the
gas valve. The screw can be identified by a red cylinder
casing around the screw. Using a thin flat head screwdriver
turn the screw clockwise to increase CO; levels and counter-
clockwise to decrease CO; levels. Turn the screw 1/4 turn in
either way for each adjustment to keep track of the
adjustments. After adjusting the screw wait a moment for the
combustion levels to stabilize before attempting to make any
further adjustments. Continue this procedure until
combustion levels are satisfied.

On the DynaMax Control Panel select ‘O’ to return to normal
operation.

To adjust the low fire setting

Use the DynaMax Control Panel

Press the [MENU] button > select Appliance Settings and
press [ENTER] > select Boiler Control and press [ENTER] >
Enter the correct Installer passcode.

Select ‘L’ for low power.

The DynaMax should respond immediately and fire at 1500
RPM. When this is achieved locate the low fire adjustment
screw as illustrated in Figure 88. Using a flat screwdriver
rotate clockwise to increase CO; levels and counter-
clockwise to decrease CO; levels. When the correct
combustion values are achieved replace the screw cap back
on to the gas valve.

On the DynaMax Control Panel select ‘O’ to return to normal
operation.

DM 500 - 750
Figure 89: DM 500 - 750 Gas Valve

LIFT TOP COVER TO ACCESS
HIGH FIRE AIR/GAS RATIO
ADJUSTMENT
(USE 3mm_ ALLEN KEY FOR ADJUSTMENT
CLOCKWISE INCREASES CO,}

LOW FIRE AIR/GAS
RATIO ADJUSTMENT,
USE FLAT HEAD
iy SCREWDRIVER
R FOR ADJUSTMENT
{CLOCKWISE INCREASES CO3)

SNLEHEL GAS INLET

To adjust the high-fire setting

Use the DynaMax Control Panel

Press the [MENU] button > select Appliance Settings and
press [ENTER] > select Boiler Control and press [ENTER] >
Enter the correct Installer passcode.

Select ‘H’ for high power. The DynaMax should respond
immediately and fire at maximum fan speed.

Locate the input adjustment screw on the top side of the gas
valve. Using a flat head screwdriver turn the screw clockwise
to increase CO- levels and counter-clockwise to decrease
COz3 levels. Turn the screw 1/4 turn in either way for each
adjustment to keep track of the adjustments. After adjusting
the screw wait a moment for the combustion levels to
stabilize before attempting to make any further adjustments.
Continue this procedure until combustion levels are satisfied.

On the DynaMax Control Panel select ‘O’ to return to normal
operation.

To adjust the low fire setting

Use the DynaMax Control Panel

Press the [MENU] button > select Appliance Settings and
press [ENTER] > select Boiler Control and press [ENTER] >
Enter the correct Installer passcode.

Select ‘L’ for low power.

The DynaMax should respond immediately and fire at 1500
RPM. When this is achieved locate the low fire adjustment
screw as illustrated in Figure 89. Using a flat screwdriver
rotate clockwise to increase CO, levels and counter-
clockwise to decrease CO; levels. When the correct
combustion values are achieved replace the screw cap back
on to the gas valve.

On the DynaMax Control Panel select ‘O’ to return to normal
operation.
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PART 11 MAINTENANCE

CAUTION
It is important that all gas appliances be serviced by a
qualified technician trained by Camus Hydronics. It is in your
own interest and that of safety to ensure that all local codes,
and all the “NOTES” and “WARNINGS” in this manual are
complied with. To service or adjust this appliance, it is
imperative that the serviceman utilize a combustion analyzer
to read CO, and CO according to Camus Hydronics
recommendations.

Listed below are items that must be checked to ensure safe
reliable operations. Verify proper operation after servicing.

11.1 EXAMINE THE VENTING SYSTEM

Examine the venting system at least once a year. Check
more often in the first year to determine inspection interval.
Check all joints and pipe connections for tightness, corrosion
or deterioration. Flush the condensate drain hose with water
to clean. Clean screens in the venting air inlet system as
required. Have the entire system, including the venting
system, periodically inspected by a qualified service agency.

11.2  VISUALLY CHECK MAIN BURNER FLAMES

At each start up after long shutdown periods or at least every
six months. A burner view port is located on the combustion
chamber front door.

CAUTION
The area around the burner view port is hot and direct
contact could result in burns

Figure 90: Normal Burner Flame Profile (short dense
and blue)

¢ Normal Flame : A normal flame at 100% of burner input
is blue, with a well defined flame and no flame lifting.

¢ Yellow Tip : Yellow tipping can be caused by blockage
or partial obstruction of air flow to the burner.

¢ Yellow Flames : Yellow flames can be caused by
blockage of primary air flow to the burner or excessive
gas input. This condition MUST be corrected
immediately.

If improper flame is observed, examine the venting system;

ensure proper gas supply and adequate supply of

combustion and ventilation air.

11.3 CLEANING BOILER HEAT EXCHANGER
Figure 91: Heat Exchanger & Burner Assembly

HEAT EXCHANGER DOOR

FLAME
SENSOR

IGNITER BURMNER

GAS
MIXING TUBE A

a) Turn the main power off to the boiler

1) Shut down boiler:

b) Shut off gas supply at the main manual valve in
the gas piping of the main appliance

¢) DO NOT drain the boiler unless it will be exposed
to freezing temperatures. If using antifreeze
prevention fluid in the heat exchanger, DO NOT
drain.

2) Allow time for the boiler to cool to room temperature if it
has been firing.

3) Remove both the stainless steel upper jacket and the
lower sheetmetal jacket.

4) Remove igniter and flame sensor electrodes. If
necessary, clean with steel wool. DO NOT use
sandpaper.

5) Remove the fan/ mixing tube assembly from the heat
exchanger door.

6) Remove burner.
7) Examine burner and clean if required as per 11.7.1.

8) Examine heat exchanger surfaces to determine if
cleaning is required. If cleaning is required remove the
(6) nuts fastening the heat exchanger flange from the
heat exchanger.

9) Use a vacuum cleaner to remove any debris that has
collected on the heat exchanger surfaces. DO NOT use
any type of solvent.

10) Finish cleaning by wiping down the boiler heating
surfaces with a clean, damp cloth.

11) Re-install the heat exchanger door by evenly torquing
down the (6) nuts to 3 ft-Ibs, burner, igniter and flame
sensor, and fan/ mixing tube assembly. Fasten the nuts
back to the heat exchanger assembly.

12) Re-connect the fan assembly to the boiler mixing tube.
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NOTE

All gaskets on disassembled components must be replaced
with new gaskets/sealant on re-assembly, if required. Gasket
kits are available from the factory

CAUTION

When the vent system is disconnected for any reason it must
be reassembled and resealed according to vent

manufacturer’s instruction

11.4 CONDENSATE TREATMENT

Condensate occurs when the products of combustion are
cooled below their dew point in the heat transfer process.
The liquid condensate formed from this high efficiency heat
transfer process is mildly acidic. The condensate will
typically have a pH ranging from 4.0to 5.0 as it is
discharged from the condensate drain of the appliance. The
condensate collection box where the condensate is collected
is constructed of a non-corrosive plastic. All materials
external to the appliance in contact with the condensate
must be corrosion resistant. Condensate must be able to
flow freely from the appliance. All condensate flow is
accomplished by gravity requiring a minimum downward
slope of 1/4” per foot (21mm/m) to ensure proper flow to a
suitable drain. A neutralizer box is mounted inside each
DynaMax. All condensate piping and connections must be
easily accessible for routine maintenance and inspection.
Use solid piping when running condensate line across the
floor. Check neutralized pH level regularly or as required by
local jurisdiction. Replace neutralizer medium as required.

11.4.1 Condensate Volume

There are several factors affecting amount of condensation
created by the appliance, however for rough approximation
use.

Condensation Volume, US Gallon/Hr = Input, MBH/1000 x
5.0

Many codes will require the acidic condensate to be
neutralized before it can be placed in a drain system. A
neutralizer to control the pH of the liquid discharged to a
drain system is provided with every DynaMax boiler. The
neutralizer consists of an industrial grade, non-corrosive
plastic reservoir for collection of the condensate. The
condensate collects in the reservoir where it is in direct
contact with calcium carbonate neutralizer medium. As the
reservoir fills, it provides an extended residence time to
neutralize the condensate. Residency time in the neurtalizer
reservoir allows time for the pH to be raised. Prime the
neutralizer reservoir with 1 litre of water.

As the condensate migrates through the reservoir in typical
applications the pH is controlled to a range of 5.5 to 6.0
before exiting the system. Always check with local codes for
specific requirements.

115 IGNITER AND FLAME SENSOR
ELECTRODES

The direct spark igniter is to be checked at every service

interval. Clean the direct spark igniter as required to maintain

peak ignition efficiency.

1) Turn off main electrical power to the appliance.
2) Turn off main manual gas shutoff to the appliance.
3) Locate the direct spark igniter and flame sensor.

4) Disconnect the power lead to the direct spark
igniter and flame sensor

5) Loosen and remove the two (2) torx screws that
hold the igniter and flame sensor to the heat
exchanger flange.

6) Pull the igniter horizontally out of the heat
exchanger flange. Use care, do not hit or break the
igniter leads.

7) Remove any debris that has accumulated on the
electrodes using steel wool. If the electrodes cannot
be cleaned to their original appearance,
replacements are needed. Do not use sand-paper
since this will contaminate the surface.

8) Check that the igniter and flame sensor gaskets are
still in good condition (no tears or seams). If the
gaskets are in good condition the electrodes can be
re-installed back to the heat exchanger flange.

9) Check that the igniter gap is 3/16".
11.6 CHECK IGNITER GROUND WIRING

1) Inspect boiler ground wire from the heat exchanger
flange to J12 of the electrical DynaMax Controller.
Check boiler ground wire continuity.

2) Verify that all wiring is in good condition and is
securely anchored.

11.7 BURNER MAINTENANCE

The burner should be removed for inspection and cleaning
on an annual basis. An appliance installed in a dust or dirt
contaminated environment will require inspection and
cleaning on a more frequent schedule. The fan assisted
combustion process may force airborne dust and dirt
contaminants, contained in the combustion air, into the
burner. With sustained operation, non-combustible
contaminants may reduce burner port area, reduce burner
input or cause non-warrantable damage to the burner. Never
operate this appliance during construction.

Airborne contaminants such as dust, dirt, concrete dust or
dry wall dust can be drawn into the burner with the
combustion air and block the burner port area.

11.7.1 Burner Removal and Cleaning
Access to the burner will require the following steps:

e Turn off main electrical power to the appliance.

e Turn off main manual gas shutoff to the appliance

* Remove the front cover.

e Disconnect the gas supply connection to the fan
inlet.

«  Disconnect the fan motor power wires at the
harness.
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¢ Remove the direct spark igniter and the flame
sensor.

¢ Remove the three (3) T-25 screws holding the front
burner flange in place to gain access to the burner.

¢ The burner can now be pulled horizontally out of
the heat exchanger cavity.

¢ Use care to prevent damage to the knitted metal
fiber of the burner surface.

¢ Wash the burner with water, such as a garden
hose. Never wipe or brush the surface of the
burner.

e For optimal results immerse the burner port area in
a solution of dishwashing detergent and hot water.
DO NOT use chlorine based solvents or cleaning
agents on the burner. Allow the burner to remain in
the solution for a short period of time to remove,
dust, dirt and oil or grease laden contaminants.

¢ Rinse the burner thoroughly with clean water to
remove any residue from the detergent cleaner

e The burner should be air dried after removal from
the cleaning solution and rinsing.

¢ Check all gaskets and replace as necessary.
Gaskets affected by heat will not reseal properly
and must be replaced.

¢ Replace the burner in the reverse order that it was
removed.

NOTE

When the combustion air fan is removed for any reason, the
inlet to the burner must be covered to prevent further foreign
objects from falling into the burner. Always look inside the
burner to check for dents. Do not place a burner back into
operation if the inner distribution screen has been dented
during the service operation, call the factory for
recommendations. Use care when removing and handling
the burner, Sharp objects or impact may damage or tear the
metal fiber surface rendering the burner unfit for service.

11.8 COMBUSTION AND VENTILATION AIR

Check frequently to be sure that the flow of combustion air to
the appliance is not obstructed unless air is piped directly to
the heater. Combustion air must be provided to the
mechanical room with openings sized per the requirements
of the current B149 or National Fuel Gas Code. The
DynaMax is setup to allow outdoor combustion air to be
connected directly to the appliance.

11.9 CONTROL CIRCUIT VOLTAGE

This appliance uses a transformer to supply a low voltage
control circuit. The voltage on the secondary side should be
24 to 28VAC when measured with a voltmeter. A secondary
voltage of 21VAC or less supplied to 24VAC components
may cause operational problems.

11.10 COMBUSTIBLE MATERIALS

CAUTION
Keep appliance clear from combustible materials; do not
store GASOLINE and other flammable vapors and liquids in
the proximity of the appliance.

11.11 FREEZE PROTECTION FOR INDOOR &
OUTDOOR INSTALLATIONS

Installations are not recommended in areas where the
danger of freezing exists. Proper freeze protection must be
provided for appliances installed outdoors, in unheated
mechanical rooms or where temperatures may drop to the
freezing point or lower. If freeze protection is not provided for
the system, a low ambient temperature alarm is
recommended for the mechanical room. Damage to the
appliance by freezing is non-warrantable.

e Location - Heating boilers, hot water supply boilers or
water heaters must be located in a room having a
temperature of at least 40°F (5°C).

e Caution - A mechanical room operating under a
negative pressure may experience a downdraft in the
flue of an appliance that is not firing. The cold outside
air may be pulled down the flue and freeze a heat
exchanger. This condition must be corrected to provide
adequate freeze protection.

*  Freeze protection for the appliance using an indirect coll
can be provided by using hydronic system antifreeze.
Follow the manufacturer’s instructions. DO NOT use
undiluted or automotive type antifreeze.

e Shut-down and draining - If for any reason, the unit is
to be shut off in a space where danger of freezing
exists, the following precautionary measures must be
taken:

o Shut off gas supply.

o Shut off water supply.

o Shut off electrical supply.

o Drain the main exchanger and the brazed plate
heat exchanger, if supplied, completely.

o Ensure that the pump and connecting piping are
fully drained.

11.12 FREEZE PROTECTION FOR A HEATING
BOILER SYSTEM (Optional)

e Use only properly diluted inhibited glycol antifreeze
designed for hydronic systems. Camus recommends
using a 30/70 mixture of glycol antifreeze to water. DO
NOT exceed a mixture of 50/50.

*  Follow the instructions from the antifreeze manufacturer.
Quantity of antifreeze required is based on total system
volume including expansion tank volume.

e Antifreeze is denser than water and changes the
viscosity of the system. The addition of antifreeze will
decrease heat transfer and increase frictional loss in the
boiler and related piping. Where antifreeze has been
used, to maintain the temperature rise across the
appliance confirm that the recommended GPM for pure
water has been increased by 15% and the head loss by
20%.

e Local codes require a back flow preventer or actual
disconnect from city water supply when antifreeze is
added to the system.

e When filling or topping-up the system with water mixed
with the antifreeze always used distilled or RO (reverse
osmosis) water. This will prevent the reaction of the
water with antifreeze which can create sludge.
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PART 12 INSTALLATIONS

WARNING

Before starting the boiler, smell near the floor and around the
boiler for any gas odours or any unusual odour. Remove the
stainless steel jacket and smell the interior of the boiler. If
there is any sign of a gas leak, do not proceed with startup.
Repair all the leaks before attempting to start the boiler.

WARNING

Propane boilers ONLY — Your local propane supplier adds
an odorant to the propane gas to allow for propane gas leak
detection. In some cases, the added odorant can fade and
the gas may not give off any noticeable odour. Before
startup have the local propane supplier check for the correct
odorant level in the gas.

12.1  CHECKING THE INSTALLATION

« Inspect the connections for water, gas and electricity.

¢ Inlet gas pressure must be a minimum of 3" W.C. for
natural gas and 11" W.C. for propane.

*  With the boiler off, open the main gas supply valve and
vent the trapped air from the piping leading to the boiler.
Confirm that all gas connections to the heater are tight
and that there are no missing test plugs.

Refer to Section 10.1 Setting the Correct Combustion of the

manual for recommendations on setting combustion

characteristics

12.2 CHECKING THE CONSTRUCTION

¢ Check the boiler wiring to see that it agrees with the
wiring diagram supplied.

«  Confirm that all terminal strips and field connections are
identified.

«  Confirm that the DynaMax Controller control is set in the
proper mode. In remote mode an external controller
determines the set point and the stage contacts on the
DynaMax Controller are always closed. Auto reset limits
are fixed in all Modes.

«  With the boiler running, check for flue gas leaks along
the inner cabinet joints and around the flue outlet.

« Repair any leaks prior to proceeding to the next step.

« Atthe factory, adjustments were made to achieve
proper input and acceptable burner performance at full
input and at minimum input.

12.3  HEATING BOILER INSTALLATIONS

Before beginning the installation, consult local codes for
specific plumbing requirements. The installation should have
unions and valves at the inlet and outlet of the appliance so
it can be isolated for service. An air separation device must
be supplied in the installation piping to eliminate trapped air
in the system. Locate a system air vent at the highest point
in the system. The system must also have a properly sized
expansion tank installed. Typically, an air charged
diaphragm-type expansion tank is used. The expansion tank
must be installed close to the boiler and on the suction side
of the system pump (appliance Inlet) to ensure proper
operation. Caution: This appliance should not be operated at
less than 12 PSIG cold. Pressure will rise when hot.
Expansion tank sizing will determine the pressure when the
system is hot. Do not operate the system at less than 18-20
PSIG when hot. Water piping must be supported by suitable
hangers or floor stands, NOT by the appliance. Pipe systems
will be subject to considerable expansion and contraction.

Pipe supports could allow the pipe to slide resulting in noise
transmitted into the system. Padding is recommended. The
boiler pressure relief valve must be piped to a suitable floor
drain. See Section 4.11.

12.4 INSPECT & RECHARGE CONDENSATE
COLLECTION/NEUTRALIZING RESERVOIR

1) Inspect the condensate reservoir in the DynaMax,
making sure the collection box is intact.

2) Remove screw holding lid on to condensate collection
box. Remove lid from the condensate collection box

3) Examine neutralizer medium and refill as necessary with
fresh medium

4)  Fill with fresh water until the water begins to flow out of
drain

5) Re-install the lid and hold-down screw on the
condensate collection box.

WARNING

The condensate collection box must be filled with water to
prevent flue gas emissions from escaping during boiler
operation.

CAUTION
A leak in a boiler “System” will cause the fill system to
introduce fresh water constantly, which may cause the tubes
to accumulate a line/scale build up. Lime/scale buildup
leading to heat exchanger failure is NOT covered by
warranty.

125 WATER CONNECTIONS

Pipe size must be in accordance with Tables 4 or 6
(depending on model) and, between supply and return lines,
must not exceed 50 feet of equivalent length. Any reduction
in recommended pipe size may decrease flow resulting in
high temperature rise across the heat exchanger, boiler
noise, flashing to steam and non-warrantable heat
exchanger damage.

12.6  PIPING LENGTHS

The appliance circulator provides the water flow from the
primary boiler piping, through the boiler and back to the
primary system. Pipe diameter and length are critical to
ensure proper flow through the boiler.

The secondary loop piping to and from the appliance must
have a fully ported ball valve installed in both the supply and
return side piping and will be used for isolation only. The ball
valves must be the same diameter as the installed piping. If
flow control is required, other means of flow control such as
globe valve or flow setter should be used.

12.7 SUMMARY

a) Typical Boiler Installations

General Plumbing Rules

1) Check all local codes.

2) For serviceability, always install unions.

3) Always pipe pressure relief valve to an open
drain.

4) Locate system air vents at highest point of
system.

5) Expansion tank must be installed near the
boiler and on the suction side of the system
pump.

6) Support all water piping.

7) Place drip pan underneath boiler. (if required)

48




b) Placing the Boiler in Operation

Pre-Start Check List

1) Review the location of the boiler, clearances
from combustible surfaces and available
service clearances.

2) Review Part 2 Venting. Ensure that all vent
components are fabricated from the correct
category of materials with adequate clearance
from combustibles.

3) Fill the condensate collector with fresh water
until water begins to pour out the drain.

4) Ensure that the boiler condensate drain and all
vent system condensate drains are properly
routed to an acceptable floor drain.

5) Review the vent termination point for proper
location and clearances.

6) If a separate combustion air pipe is used,
ensure that it is properly sized, sealed and
terminated.

7) Review the water piping from the boiler to the
system. The boiler must be installed in a
primary/ secondary piping system. Review the
diameter and equivalent length of the installed
piping to and from the boiler to ensure proper
flow.

8) Ensure that a properly sized system pump is
installed with an expansion tank.

9) Check system pressure. Ensure a minimum of
18-20 PSIG with the system hot and not more
than 90% of the rated pressure of the relief
valve.

10) Review the installed gas piping from the meter
to the boiler. Ensure that the gas pipe, meter
and any regulators are adequately sized.

11) Review the field wiring and electrical service
for the boiler controls. Ensure that the electrical
service(s) is adequately sized.

Boiler Set-Up

1) Ensure that the boiler and piping system are
full of water. Bleed all air from the pump
housing and secondary loop.

2) Check system for any water leaks.

3) Check system for installation of glycol or water
treatment where required. Where glycol has
been used to maintain the temperature rise
across the appliance confirm that the
recommended flow for pure water has been
increased by 15% and the head loss by 20%.

Boiler Operational Checks

1) Turn the boiler main power switch to the “ON”
position.

2) Verify operation of the text display on the front
panel.

3) Program the adjustable points.

4) Push the reset button if a lockout error is
displayed.

5) Install a manometer on the gas supply to the
boiler and verify minimum gas supply pressure
as the burner fires at 100% of rated input.

6) Verify operation of safeties as necessary (low
water cut-off, high limit, gas pressure, etc.).

Boiler Operation

1) Appliance should begin the start-up process for
the sequence of operation.

2) The boiler will fire at 50% of rated input on
initial start-up and adjust input as required to
meet system demand.

3) Based on system demand, the appliance will
modulate accordingly.

4) As system demand is satisfied, the burner will
fire at minimum fire for the given demand and
the boiler will cycle off when the demand
ceases or is interrupted. When this occurs the
combustion air fan will decelerate at a pre-
programmed rate before the appliance shuts
down.

12.8 DOMESTIC HOT WATER WITH STORAGE
TANK

Hot water heaters are designed for installation with a storage
tank. The piping between the tank and heater and the control
of water velocity, as explained below, are important for
correct operation of your hot water heater.

129 DOMESTIC HOT WATER WITH PLATE
HEAT EXCHANGER

The piping between the plate heat exchanger in the
DynaMax boiler and to an outlet tap is important for correct
operation of the plate heat exchanger. The following
procedure should be followed for setting the domestic hot
water tuning valve:

1) There is a temperature tuning valve inside the
Dynamax jacket on the domestic hot water outlet
from plate exchanger . This valve can be set for
field conditions .

2) Firstidentify the highest domestic hot water load .
For example in some cases it may be the bath tub
and in some cases it may be the clothes washer.

3) Allow the Dynamax to fire up and reach full fire
under maximum hot water load demand conditions .

4) Observe the outlet water temperature and close the
tuning valve gradually as outlet temperature starts
to drop . Allow the system to reach equilibrium
between adjustments to the tuning valve .

5) Once the tuning valve is properly set, outlet
temperatures will never drop below
desired minimum temperature.

6) Seal stem of tuning valve with silicone to prevent
unauthorized tampering .
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12.10 TEMPERATURE RISE AT FULL FIRING
RATE

1) The pump must run continuously when the burner is
firing.

2) With the pump running and the burner in the water
heater or hot water supply boiler in the off cycle, the
Return/Inlet temperature and Supply/Outlet temperature
readings on the DynaMax Control Panel should read
approximately the same temperatures.

3) Turn the hot water heater on and allow time for the
temperature to stabilize. Check the temperature rise
when the burner is firing at 100% of rated input.

4) Compare the temperature rise on the Control Panel with
the required temperature rise at the required flow rate
on Tables 39 and 40.

5) Should adjustment be needed, proceed as follows:

6) The DynaMax uses stainless steel heat exchanger
tubes which are not sensitive to higher water velocity. If
temperature rise is lower than anticipated it is not
necessary to reduce flow.

If the temperature rise is too high, the water velo  city is
too low. Adjust as follows:

1) Check for flow restrictions. Check for debris in strainers

2) Check diameter and equivalent length of the piping
between the storage tank and hot water heater.

3) Be sure all valves are open between the hot water
heater and the storage tank. Ensure that all ball valves
are fully ported.

4) Check the pump to be sure it is running properly and
that the pump motor is running in the proper direction.

5) Be sure the pipes between the hot water heater and
storage tank are not more than a total of 50 equivalent
feet between supply and return lines. If maximum
equivalent length for the specified pipe diameter is
exceeded, larger diameter pipe may have to be installed
to achieve correct flow and temperature rise.

6) Common manifold piping for multiple unit installations
will require larger minimum pipe sizes and tank
circulating tapping to ensure proper flow.

The required temperature rise and the recommended pump
size are based on the heating of potable water with a
hardness of 7.5 to 17.0 grains per gallon and a total
dissolved solids not exceeding 300 PPM. Consult the factory
when heating potable water exceeding these specifications.
Water with a hardness of less than 5 grains per gallon will
usually have a low pH which can be aggressive and
corrosive causing non-warrantable damage to the heater,
pump and associated piping. Refer to Tables 39 and 40 for
reference.

Table 39: Temperature Rise Across Heat Exchanger
(Hydronic Heating)

TEMPERATURE RISE ACROSS HEAT
EXCHANGER
MODEL 30°F (16.7°C) 35°F (19.4°F)
[BTUNT 1 yscpm | ap-rt. | uscpm | ap-Ft.
80,000 5.0 8.2 4.3 6.2
100,000 6.3 12.3 5.4 9.4
150,000 9.5 10.4 8.1 7.8
200,000 12.6 7.2 10.8 5.8
250,000 15.8 11.5 13.5 8.7
299,000 18.9 9.3 16.2 7.0
399,000 25.2 8.4 21.6 6.3
500,000 31.5 9.2 27.0 6.9
600,000 35.9 14.7 32.0 11.8
750,000 44.9 221 40.0 14.4

Table 40: Temperature Rise Across Heat Exchanger (D HW)

TEMPERATURE RISE ACROSS HEAT

EXCHANGER
MODEL 20°F (11.1°C)
[BTU/hr] USGPM AP-Ft.
80,000 75 115
100,000 9.4 26.9
150,000 14.0 27.8
200,000 19.2 25.9
250,000 23.5 28.3
299,000 28.8 25.8
399,000 38.4 23.9
500,000 48.6 29.4
600,000 57.6 34.2
750,000 70.4 40.0

CAUTION

Temperature rise cannot be adjusted when the burner is
firing at less than 100% of input rate.

CAUTION

Adequate care MUST be taken to prevent potential scald
injury when storing water at 140F (60<C) and hotte r.

WARNING

Should overheating occur or the gas supply fail to shut off,
do not turn off or disconnect the electrical supply to the
pump, instead, shut off the gas supply at a location external
to the appliance
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12.11 SETTING THE CORRECT COMBUSTION
Refer to Section 10.1 Setting the Correct Combustion.
12.12 CASCADE SETUP

The DynaMax can be placed into a multiple boiler system in
a cascade setup. In such a cascade configuration all boilers
should be connected with an additional connection between
the master DynaMax boiler and the slave DynaMax boiler

12.12.1 Programming the Cascade Setup

Figure 92: Rear view of DynaMax Controller

To Dynalax
< _* Controller

To Next Display 1\

To Previous Display

Switch ON  Switch OFF

Positon Position
To setup a multiple boiler system the wiring setup is shown
in Figure 96. The DynaMax Control Panel has 3 Molex Minifit
Jr connections on the rear. Use the DynaMax Control Panel
Power connector to connect to the DynaMax controller and
use the double connector to link to the other displays.

Figure 93: Wiring of Cascade Setup

DynaMax DynaMax DynaMax DynaMax
Controller Controller Controller [~~~ 1 Controller
Haster Slave Slave Slave
Address = 1 Address = 2 Address = 3 Address = X
DynaMax DynaMax DynaMax DynaMax
Control Control Control Control
Panel Panel Panel Panel
[ [N ] es 8 (RN W]

L |w & = L [» = = L | & &l — L | & @
Rl Bl | el B i
t | T | 1
Haster Slave Slave Slave
Switch = ON Switch = OFF Switch = OFF Switch = OFF

The boiler addresses for each boiler must be set individually,
therefore DO NOT electrically connect the boilers together
during the setup process.

Procedure to Setup a Cascade System (Master Boiler)

e Using the DynaMax Control Panel access the
Cascade Control screen.

*  MENU > Appliance Settings > Cascade Control

e Enter the Installer Password to gain access to the
Cascade Control parameters

*  For a Master boiler, select address location 1 and
press STORE. Check to see on the DynaMax
Control Panel that the Switch is placed in the ON
position as shown in Figure 95.

*  Now the Master boiler has been programmed.

Procedure to Setup a Cascade System (Slave Boiler)

e Go to the next boiler in the Cascade system and
using the DynaMax Control Panel access the
Cascade Control screen.

*  MENU > Appliance Settings > Cascade Control

e Enter the Installer Password to gain access to the
Cascade Control parameters

e Address location 1 has already been reserved for
the Master boiler, the slave boiler will need to be
programmed with the next available address
location. Press STORE when desired address is
shown.

e A switch located on the back of the DynaMax
Control panel must be placed into the OFF position
for all Slave boilers as shown in Figure 95.

*  Now the Slave boiler has been programmed.

e Continue this process until all DynaMax boilers in
the cascade system are programmed.

When all boilers have been programmed electrically connect
the boilers together.

DISPLAY

READOUT DESCRIPTION

CASCADE
CONTROL

Cascade Delay Delay time for switching
Time on/off next boiler with
ch_setpoint is not satisfied

Hysteresis to start or stop
the next slave boiler(s).
Start slave boiler condition:
T_supply < CH_Setpoint -
Casade Hysteresis. Stop
slave boiler condition:
T_supply > CH_Setpoint +
Cascade Hysteresis

Cascade Hysteresis

12.13 APPLIANCE

Remove manometers and tighten test port screws.

Fill out start up report for each heater. Be sure to record
all settings and readings. Retain a copy of report for
future reference.

Start up is now complete and heater may be placed into
service.
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12.14

IGNITION CYCLE

The ignition cycle is shown in the table below. The values are the default factory settings.
Table 41: DynaMax Ignition Cycle

State > = Standby  Pre Purge Safety ON Safeta/ Ignit_0 Ignit_1
OFF
5s after Limited to
Time 0s fz_:m s_pe_ed 2 sec 6 sec 24 hours Max. 10 10 sec.
is within continuous sec
600rpm ly®
No No No No No No No
Demand 0 influence | influence | influence | influence | influence >0 influence | influence
= Ignition Ignition Ignition Ignition Ignition | Requested | Ignition Ignition
an Off
speed speed speed speed speed power speed speed
Gasvalve Closed Closed Closed Closed Closed Open Open Closed Closed
Spark Off Off Off Off On on* Off Off Off
Flame Flame No flame
lonisation 0 0 0 0 o' must be must be must be 0
detected” | detected | detected®

Note:

1. If a flame signal is detected at the end of the pre-sprak period (Ignit_0) then a lockout will occur.

2. If at the end of the safety period (6 sec) no flame is detected the control will go to post-purge to remove the unburned gas.
After this a re-ignition attempt is started following the same cycle. The number of re-ignition attempts is limited to 2 after
which a lockout occurs.

3. The burner can only be on continuously for a period of 24 hours. After this the burner is switched off and a restart
sequence follows.

4, Sparking stops 2 seconds before the end of the Ignit_1 period to allow for ionisation detection when measuring ionisation
through the spark plug.

5. If after post_purge_0 time (max. 10 sec.) still flame is detected lockout follows

6. Safety ON/OFF in this state the correct working of the safety relay is proved.

If the ignition cycle is started it will continue until completion, even if the demand is removed.
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PART 13 PIPING DIAGRAMS

Figure 94: Single Boiler Hydronic Heating Zoned Pip  ing Arrangement

This piping arrangement is designed for:
Central Heating Mode: 0, 1, 2, or 3
DHW Mode: 0
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Figure 95: Single Combination Boiler Zoned Piping A

rrangement
Central Heating Mode: 0, 1, 2, or 3
DHW Mode: 3, or 4
Boiler Address: Boiler Address = 100
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Figure 96: Single Boiler Hydronic Heating & Indirec

Central Heating Mode: 0, 1, 2, or 3
DHW Mode: 1, or 2

Boiler Address: Boiler Address = 100
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Figure 97: Single Boiler Hydronic Heating & Indirec  t Storage Tank Non-Zoned Piping Arrangement

Central Heating Mode: 0, 1, 2, or 3
DHW Mode: lor 2
Boiler Address: Boiler Address = 100
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Figure 98: Single Boiler Hydronic Heating & Direct Storage Tank Zoned Piping Arrangement

Central Heating Mode: 0
DHW Mode: 1 or 2
Boiler Address: Boiler Address = 100
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Figure 99: Multiple Boiler Hydronic Heating Zoned P

Central Heating Mode: 0, 1, 2, 3
DHW Mode: 0

Master Boiler Address = 101
Slave Boiler Address = 102

Boiler Address:
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PART 14 EXPLODED VIEW & PARTS LIST
DYNAMAX WALL HUNG
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DYNAMAX FLOOR MOUNT
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Re; Name of Part Part ID DRTIEL X 1) B
# ALL | 80 | 100 | 150 | 200 | 210 | 250 | 260 | 299 | 399 | 500 | 600 | 750
4 + 1 Wall X X
5+ 2 Wall X
8+ 4 Wall X X
8 + 4 Floor X X
1 Heat 10 + 6 Floor X
Exchanger
15 + 8 Floor X
18 + 10 Floor X
24 +11 Floor X
24 + 12 Floor X
80,000 BTU X
100,000 BTU X
150,000 BTU X
200,000 BTU X X
5 Burmer 250,000 BTU X X
299,000 BTU X
399,000 BTU X
500,000 BTU X
600,000 BTU X
750,000 BTU X
Heat GM20-65-028-01 X X X
3 Exlzclgﬁgger GM20-65-033-01 X | x [ x| x| x| x| x
Heat
4 Exchanger GM10-05-012 X
Flange Nuts
5 Igniter GM10-35-108 X
6 Flame Sensor GM10-35-109
7 Igniter/Flame GM10-05-020
Sensor Screws
8 DynaMax 848MN X
Controller
DynaMax
9 Con);rol Panel 848RC X
DynaMax
10 Condensate 15-6010 X
Neutralizer Box
55667.11221 X X
55667.21120 X
. 55667.01970 X
11 ComFba”:t'O” 55667.21080 X | X | X
55667.21200 X X
55667.14002 X
G1G 170 X X
459000-444-003 X X
459000-444-001 X
. 459000-446-051 X X X X
12 ventur 45900450-010 X
45900450-020 X
VMU300A1046 X X X
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Re; Name of Part Part ID DRTIEL X 1) B
# ALL | 80 | 100 | 150 | 200 | 210 | 250 | 260 | 299 | 399 | 500 | 600 | 750
VK8115 V1036 X X X X X X X
13 Gas Valve VR8615VB1044/B X X
V8730V1015 X X X
Astro 30 X X
Astro 50 X X X
S25 X X
Pump (Non E- S35 X | X | X | X | X | X | x| X
Series)
PL30 X X X
PL36 X X X
PL45 X
E7 X
14 ES8 X X X X X X X
Pump (E E9 X X
Series) Ell X X X
E12 X X
E16 X X X X
E33 X X
Pump (H H54 X
Series) H66 X
H67 X
15 Mixing GM20-70-011 X X X
Chamber GM20-70-020-01 X X X X X X
16 | AiIrPressure 8021205256 X
Switch
3-Way Valve
17 (Combination VC40117702/E X X X X X X X X X X X X
Models ONLY)
18 High Limit TCL 110A X
Wall Hung X
19 Y4 Turn Lock Floor Mount X
DynaMax Wall
20 Mount Back 14-5402 X X X
Panel
DynaMax Wall
21 Mount Front 14-5403 X X X
Bottom Wrap
DynaMax Wall
22 Mount Front 14-5404 X X X
Upper Wrap
23 | DynaMax wall 14-5405 X | x| x| x X
Mount Restrain
DynaMax Wall
24 Mount 14-5406 X | x| x| x X
Mounting
Bracket
DynaMax Wall
25 Mount Wall 14-5407 X X X X X
Lower Bracket
DynaMax Wall
26 Mount Wall Top 14-5408 X X X X X
Bracket
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Ref

Name of Part

Part ID

DynaMax Models

ALL

80

100

150

200

210

250

260

299

399

500

600 | 750

27

DynaMax Wall
Mount Support
Frame
Assembly

14-5409

28

DynaMax Wall
Mount Bracket
Front

14-5410

29

DynaMax Wall
Mount Rear
Bracket

14-5411

30

DynaMax Wall
Mount Bezel
Stiffener Plate

14-5412

31

DynaMax Wall
Mount
Controller Plate

14-5413

32

DynaMax Wall
Mount
Electrical
Conduit Plate

14-5415

33

DynaMax Wall
Mount
Electrical Strip
Plate

14-5416

34

DynaMax Wall
Mount Plastic
Bezel

15-6001-A

35

DynaMax Wall

Mount Bracket

for Neutralizer
Box

14-5419

36

Air Inlet/ Vent
Adapter

FSA-HEXO03

37

Plate Heat
Exchanger
(Combination
Models ONLY)

LB31-20X

LB31-40X

38

DynaMax Floor
Front Panel

14-5501

39

DynaMax Floor
Base Panel

14-5502

40

DynaMax Floor
Top Cover
Front

14-5503

41

DynaMax Floor
Back Panel

14-5504

42

DynaMax Floor
Top Cover
Back

14-5505

43

DynaMax Floor
Side Panel
Right

14-5506

44

DynaMax Floor
Side Panel Left

14-5507
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Ref

Name of Part

Part ID

DynaMax Models

ALL

80

100

150

200

210 | 250 | 260

299

399

500

600

750

45

DynaMax Floor
Front Panel
Bottom

14-5508

X X

46

Dynamax Floor
Side Panel Left
Front

14-5509

47

DynaMax Floor
Control Panel
Plate

14-5510

48

DynaMax Floor
HX Support
Frame

14-5511

49

DynaMax Floor
Support Plate

14-5512

50

DynaMax Floor
Bracket Right

14-5513

51

DynaMax Floor
Stand Off Left

14-5514

52

DynaMax Floor
Stand Off Right

14-5515

53

DynaMax Floor
Support Leg

14-5516

54

DynaMax Floor
Stiffner under
Leg

14-5517

55

DynaMax Floor
Bracket Left

14-5518

56

DynaMax Floor
Rear Bracket

14-5520

57

DynaMax Floor
Mount Top
Cover
Assembly

14-5521

58

DynaMax Floor
Mount
Dashboard

15-6002-A

59

DynaMax Floor

Mount Bracket

for Neutralizer
Box

14-5525

60

Rubber
Bushing

33-0101

61

DynaMax Wall
Mount
Condensate
Pan

14-5414

62

DynaMax Wall
Mount
Condensate
Pan Brace

14-5417

63

Cover Plate

14-5421

64

Standoff

14-5423

65

Standoff

14-5422
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Ref DynaMax Models
Name of Part Part ID
# ALL | 80 | 100 | 150 | 200 | 210 | 250 | 260 | 299 | 399 | 500 | 600 | 750
Electrical Strip
66 | plate Protector 14-5420 X
DynaMax Wall
67 Mount Air 44-0008 X X X X X
Intake Adapter
DynaMax Floor
Mount Plastic
68 Flange with 3" 44-0009 X X X
Street Elbow
DynaMax Floor
69 Mount Air 44-0010
Intake Adapter X X X
70 Igniter Gasket GM10-25-018
71 | FlameSensor | gy16.25.004
Gasket
72 Burner GM10-25-098-01 X X X
Refractory GM10-25-107 X | X | X | x| x| x| X
73 Automatic Air FV-AM1 X
Vent
DynaMax
7431 Terminal Board TB-001.001
75 On/Off Switch W51A152A
76 40VA HCT-01E0BBO6 | X
Transformer
77 | Supply/Retum TSDOOAS X
Sensor
78 Flue Sensor TSD20A1
Sensor Wire
79 | (DMH/DMW: 3, H,EQEJEES X
DMC: 4)
DHW Sensor
80 (Clip-on, TSC 0ASO X
Combination
Models ONLY)
81 Burner Gasket | GM10-25-074-09 X X X X X X X X X
82 Gas Valve 45900400-132/B X X X X X X X
Elbow 45900400-144/B X | X
83 Gas Valve Wire | 45900441-015B X X X
Harness 45900429-007B X X X X X X
. 10-407-05 X X X X X X X
84 Relief Valve 10-604-10 X X X
. 77-0004 X X X X X
W H
85 iring Harness 27-0006 X X X X X
Flow Sensing
86 | Device (Current RIBXGA X X X X X
Transformer)
1/2" Firing
87 Valve USA0509101T X X X X X
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R3; Name of Part Part ID DynaMax Models
# ALL | 80 | 100 | 150 | 200 | 210 | 250 | 260 | 299 | 399 | 500 | 600 | 750
DynaMax Fan
88 Discharge 14-0377 X X X X X X X
Orifice
Expandable Air
gg | Inlet Adapter 14-0378 X | x | x| x X
w/o Pressure
Test Point
go | Expandable Air 14-0379 X | x| x| x X
Inlet Adapter
) 2" Diameter X X X X X X X X X
91 Flex Pipe -
3" Diameter X X X
Flexible
92 | Stainless Steel 66-0075 X
Pipe 1" X 11"
Flexible
93 | Stainless Steel 66-0073 X
Pipe 1/2" X 11"
g4 | Manual Shutoff | ono6e3 601
Valve Kit
95 Rear Vent GM10-15-991-01 X X
Adapter GM10-15-992-01 X X X
96 Metal Latch 6521-00-0551-YT X X X X X X X
97 Strike 7800-02 X X X X X X X

I:l Not shown in Exploded View
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DM 80- 250 INTERNAL WIRING DIAGRAM (WALL HUNG MODELS)
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DM 210- 750 INTERNAL WIRING DIAGRAM (FLOOR MOU NT MODELS)
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15.3 FIELD WIRING
15.3.1 System Sensor

The temperature of the primary return can be controlled by
installing a system sensor. The DynaMax Controller
automatically detects the use of this sensor and controls
the burner modulation rate accordingly to maintain the
system supply temperature to the set point.

15.3.2 Boiler Management System

An external controller can be connected to control the
modulation rate of the burner, set point temperatures along
with other user accessible parameters. To gain access to
this function connect the 0-10Vdc terminals on the terminal
board to the 0-10Vdc terminal on the boiler management
system.

To allow for proper functionality ensure that the ‘+’ terminal
is connected to the ‘+’ terminal on the terminal board and
the ‘- terminal is connected to the ‘- terminal on the
terminal board.

15.3.3 Cascade Setup

To setup a cascade system a Master boiler must be
chosen, and the other boilers connected to it in this system
are designated as Slaves.

Connect the system sensor and outdoor sensor (if
equipped) to the Master boiler. The Master boiler will use
the water temperature in the primary loop to control the
operation of the cascade setup. The location of the system
sensor should be installed downstream of all the zones in
the primary loop. The system sensor is wired into the
DynaMax Terminal board as shown in the diagram below.

If outdoor reset is desired, the outdoor sensor needs to be
connected to the Outdoor Sensor location on the DynaMax
Terminal Board. When the outdoor sensor is connected to
the Master boiler, the DynaMax Controller will recognize
this automatically and the Master will calculate the water
temperature setpoint based on the Ch_Setpoint Curve
(Figure 15). If the outdoor sensor is not connected to the
Master boiler the DynaMax Controller will maintain a fixed
water temperature that is programmed into the control.

If a Zone Thermostat is available, it needs to be connected
to the Room Thermostat terminals on the DynaMax
Terminal Board. If the boiler is required to run continuously
a jumper cable can be placed between the ‘+’ and ‘-
contacts, this will then force a call for heat on the cascade
setup.

Communication between the Master and Slave boilers is
accomplished by a running shielded 2-wire cable. Connect
one end of the wires to Master ‘Cascade +' and the other
end to Slave ‘Cascade +' on the DynaMax Terminal Board.
Setup the other wire in the same manner with one end of
the wires to Master ‘Cascade -’ and the other end to Slave
‘Cascade — on the DynaMax Terminal Board. If more than
2 boilers are connected in a cascade fashion, daisy chain
the wiring from the second boiler on the Cascade DynaMax
Terminal Board to the third boiler on the Cascade
DynaMax Terminal Board. Do the same for the third, the
fourth etc. Keep the wires short to minimize the chance of
interference signals.

l,f‘\l Ix"‘\.
- gt
o
i GROUND (SUPPLY TO BOILER
120%ac
el LIVE (SUPPLY TO BOILER)
N3 NEUTRAL (SUPPLY TO BOILER)
= Sytemr 5 iDj:l
L. iiE SYSTEM SENSOR
Eoomrp 7
\ ) AT ZOME THERMOSTAT
Flow /WO [ 2 .| FLOW SWITCH
e
" Qutdoor 1! =| OUTDOOR SENSOR
senscr L12 O BUILDING
9.1Wd5[+‘3 o MANAGEMENT
14 SV STEM
DHW 15 F{ [T 1 oHw SENSOR
Sensor L {8
Cascade| * :;_ TO NEXT BOILER
TR ; >
zwac[m bt r{‘ 248 RELAY
a - FROM PREVIOUS
- w BOILER
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15.4 DETAILED CONNECTOR DESCRIPTION

Connector | Pin# Connector Description Pin
Provides 120VAC to the Connector # Connector Description
DynaMax Controller Various Sensors
J2 1 Earth/ Ground 1 | Room Thermostat, 24VAC
2 120VAC Neutral 2 | Control Panel, +
3 120VAC Live 3 | Supply/Outlet Sensor
3-Way Diverter Valve 4 | Return/Inlet Sensor
1 DHW 120VAC Live 5 | DHW Sensor/ Tank Stat
36 2 CH 120VAC Live 6 | Flue/Stack Sensor
3 120VAC Neutral 7 | System Sensor
On-Board Pump J5 8 | Outdoor Sensor
1 Not Used 9 | Room Thermostat, 24VAC
2 Pump 120VAC Neutral 10 | Control Panel, -
I7 3 Not Used 11 | Supply/Outlet Sensor
4 Not Used 12 | Return/Inlet Sensor
5 Pump 120VAC Live 13 | DHW Sensor/ Tank Stat
High-Limit, Gas Valve, Flame 14 | Flue/Stack Sensor
Sensor 15 | System Sensor
1 120VAC Ground 16 | Outdoor Sensor
2 Flame Sensor J12 Spark Return Signal
J13 3 Gas Valve 120VAC Neutral T2 Spark Igniter
F1 3.15A Fuse
4 Gas Valve 120VAC Live
2 High-Limit Safety
Fan Power, Fan Modulation
1 Fan 120VAC Earth/ Ground
2 Fan 120VAC Live
39 3 Fan 120VAC Neutral
4 Fan Signal +
5 Fan Hall Effect Signal
6 Fan PuIS(_e Width Modulation
(PWM) Signal
7 Fan Signal -
Various Sensors
1 Flow Switch
2 Air Switch
3 Flow Switch
Jie 4 Air Switch
5 Not Used
6 0-10vVDC Analog Input
7 Not Used
8 0-10VDC Analog Input
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CONDENSING BOILER LIMITED WARRANTY

Camus Hydronics Limited (“Camus”) extends the following
LIMITED WARRANTY to the owner of this appliance, provided
that the product has been installed and operated in accordance
with the Installation Manual provided with the equipment. Camus
will furnish a replacement for, or at Camus option repair, any part
that within the period specified below, shall fail in normal use and
service at its original installation location due to any defect in
workmanship, material or design. The repaired or replacement
part will be warranted for only the unexpired portion of the original
warranty.

THISLIMITED WARRANTY DOESNOT COVER

1. Failure to properly install, operate or maintain the equipment
in accordance with Camus’ manual

2. Abuse, alteration, accident, fire, flood, foundation problems
and the like

3. Sediment or lime build-up, freezing, or other conditions
causing inadequate water circulation

4. Pitting and erosion caused by high water velocity;

5.  Failure of connected systems devices, such as pump or
controller

6. Use of non-factory authorized accessories or other
components in conjunction with the system;

7. Falling to eliminate air from, or replenish water in, the
connected water system

8. Chemical contamination of combustion air or use of chemical
additives to water

9. Production of noise, odours, discolouration or rusty water

10. Damage to surroundings or property caused by leakage or
malfunction

11. All labour costs associated with the replacement and/or
repair of the unit

12. Any failed component of the hydronic system not
manufactured as part of the boiler.

HEAT EXCHANGER

If within TWELVE years after initial installation of the appliance, a
heat exchanger shall prove upon examination by Camus to be
defective in material, thermal shock, leakage or workmanship,
Camus will exchange or repair such part or portion on the

following pro rated limited warranty
Years into Warranty % of List Price
8 30
9 40
10 50
11 60
12 70

This term is reduced to SIX years if the appliance is used for other
than hydronic space heating. Heat Exchanger shall be warranted
for (20) years from date of installation against “Thermal Shock”
(excluded, however, if caused by appliance operation at large
changes exceeding 150°F between the water temperature at inlet
and appliance temperature.

BURNER

If within FIVE years after initial installation of the appliance a
burner shall prove upon examination by Camus to be defective in
material or workmanship, Camus will exchange or repair such part
or portion.

ANY OTHER PART

If any other part fails within one (1) year after installation, or
eighteen (18) months from date of factory shipment based on

Camus' records, whichever comes first. Camus will furnish a
replacement or repair that part. Replacement parts will be shipped
f.o.b. our factory.

DURATION OF LIMITED WARRANTY

Any limited warranty, including the warranty of mechantability
imposed on the sale of the boiler under the laws of the state or
province of sale are limited in duration to one year from date of
original installation.

STATELAW & LIMITED WARRANTY

Some states or provinces do not allow:

a) Limitations on how long an implied warranty lasts

b) Limitations on incidental or consequential damages.

The listed limitations may or may not apply to you. This warranty
gives you specific legal rights, and you may also have other rights
which may vary from state to state and province to province.

CONDITIONS

We will not:

a) Repair or replace any boiler, or part, subject to
conditions outlined in ‘This Limited Warranty Does Not
Cover’

b) Reimburse any costs associated with repair and/or
replacement

c) Replace and/or reparir any boiler without complete
model numbetr/serial number

d) Replace any boiler without prior receipt of actual rating
plate from the appliance.

HOW TO MAKE A CLAIM

Any claim under this warranty shall be made directly to Camus
Hydronics Limited Canadian Head Office

SERVICE LABOR RESPONSIBILITY

Camus shall not be responsible for any labour expenses to
service, repair or replace the components supplied. Such costs
are the responsibility of the owner.

DISCLAIMERS

Camus shall not be responsible for any water damage. Provisions
should be made that in the event of a water/appliance or fitting
leak, the resulting flow of water will not cause damage to its
surroundings.

Name of
Owner

Name of
Dealer

Address

Model No.

Serial #:

Date of Date of Initial
Installation: Operation:

6226 Netherhart Road, Mississauga, Ontario, L5T 1B7, CANADA
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CAMUS Hydronics is a
manufacturer of
replacement parts for
most copper finned

water heaters
and  heating
boilers as well
as a

supplier of specialty
HVAC products. Our
service line is open 24
hours, 7 days a week !

JE:AI‘J!US_'

CERTIFIED! | For ~ more

The CAMUS
CERTIFIED! Seal
assures you that
Reliability, Efficiency &
serviceability are built
into  every
single unit!

information

on our innovative
products from CAMUS
Hydronics Limited, call
905-696-7800 today.

CAMUS HYDRONICS LTD.

6226 Netherhart Road, Mississauga, Ontario L5T 1B7

TEL: 905-696-7800 FAX: 905-696-8801




